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1Getting Started
Welcome to PREMIER+™ 2 Embroidery Extra.

In this guide we will use the name PREMIER+™ 2 Embroidery to refer to features available in both modules. 
Screen captures show PREMIER+™ 2 Embroidery Extra.
PREMIER+™ 2 Embroidery helps you to adjust your embroideries on the computer before 
you sew. Personalize your embroideries in true 3D in a real hoop. Rotate your embroideries 
to any degree, mirror them from side to side or end to end and scale or resize your 
embroideries. Adjust an unlimited number of designs and lettering ’side by side’ in 
multiple windows.

See the PREMIER+™ 2 Embroidery User Guide for more information on these and other features.

PREMIER+™ 2 Embroidery Extra Features
In PREMIER+™ 2 Embroidery Extra, use 2D editing to alter individual stitches or whole 
blocks of stitches, even insert new stitches. Manage colors in your embroideries: move 
colors up or down, merge color blocks and insert color changes.

Audition Features
Use the Background Wizard  to view your embroideries on real garments, fabrics and 
quilt blocks. Also view and reposition an unlimited number of appliqués on your designs.

ExpressDesign Wizard
PREMIER+™ 2 Embroidery Extra also includes the ExpressDesign Wizard . Use it to 
automatically create embroideries from a picture, either to fit the current hoop or to fit an 
area you select. Choose from three design types:

PhotoStitch Wizard
Use the PhotoStitch Wizard  to create new embroidered PhotoStitch portraits 
automatically from photos. Generate a linear pattern of stitches, or a Maze or Spiral effect, 
using one thread for a single color result.

Express Embroidery Express Trace Express Border

Create a standard embroidery 
using satin, fill areas and 
outlining.

Trace outlines in a picture to 
create, for example, redwork, 
quilt stencils and so on.

Create satin line, appliqué, 
running stitch, triple stitch or 
motifs around the edges of solid 
color areas in the picture.
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Color PhotoStitch, Sepia PhotoStitch, Monochrome PhotoStitch and Color Tile PhotoStitch options are 
also available in the PhotoStitch Wizard if you own PREMIER+™ 2 ULTRA.

Word Sculpt Wizard
Use the Word Sculpt Wizard  to create a word design automatically using your choice 
of outline, words, and fonts.

Project-in-the-Hoop Wizard
Use the Project-in-the-Hoop Wizard  to create an in-the-hoop design using your 
choice of project type, style and dimensions. 

Quilt Block Wizard
Use the Quilt Block Wizard  to create a filled or outline quilt block automatically.

Family Tree Wizard
Use the Family Tree Wizard to create an embroidery chart of your family’s history quickly 
and easily. If desired, add individual pictures or PhotoStitch embroideries in PREMIER+™ 2 
Family Tree.

The Family Tree Wizard is available if you own PREMIER+™ 2 ULTRA.

Split Project Wizard
Use the Split Project Wizard  to split your embroidery automatically for your preferred 
hoop.

Color PhotoStitch 
Embroidery

Sepia PhotoStitch 
Embroidery

Monochrome 
PhotoStitch 
Embroidery

Color Tile 
PhotoStitch 
Embroidery

Linear PhotoStitch 
Embroidery

Create an 
embroidery from a 
color photo, using 
multiple threads 
for a full color 
result.

Create a sepia 
embroidery from 
a photo to give a 
heritage look, 
similar to old 
photos.

Create a grayscale 
embroidery from 
a black and white 
photo

Create an 
embroidery from a 
color photo, 
generating small 
blocks of stitches 
with a tiled effect.

Create a single thread 
embroidery from a 
photo, generating a 
linear pattern of 
stitches, or a Maze or 
Spiral effect.

Filled Quilt Block; 
Inner Embroidery

Outline Quilt Block; 
Filled Inner Shape

Filled Quilt Block; 
Outline Inner Shape

Filled Quilt Block; 
No Inner Shape

Outline Quilt Block; 
No Inner Shape
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Parts of the Software Window

Ribbon Bar
There are 13 tabs on the ribbon: File, Home, Wizards, Encore, Letter, SuperDesign, Frame, 
Border, Appliqué, Decoration, Modify, View and Help. 

The Wizards and View tabs contain some features only available in PREMIER+™ 2 Embroidery Extra, and 
the Appliqué, Decoration and Modify tabs are only available in PREMIER+™ 2 Embroidery Extra.

Wizards Tab
Use the Wizards tab to access the nine wizards: the ExpressMonogram Wizard , the 
Endless  wizard, the ExpressDesign Wizard , the PhotoStitch Wizard , the  Word 
Sculpt Wizard , the Quilt Block Wizard , the Family Tree Wizard , the Project-in-the-
Hoop Wizard  and the Split Project Wizard . 

The ExpressDesign 
Wizard, the 
PhotoStitch Wizard, 
the Word Sculpt 
Wizard, the Quilt Block Wizard, the Project-in-the-Hoop Wizard and the Split Project Wizard are only 
available in PREMIER+™ 2 Embroidery Extra. The Family Tree Wizard is available in PREMIER+™ 2 ULTRA.

Appliqué Tab

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar

Design PanelStatus Bar Work Area

Audition a fabric for 

Delete an appliqué piece
Insert and Delete points in the outline of an appliqué area
Select an appliqué area, or move to another areaDefine the outline of an appliqué area

Cut a hole in an appliqué area

the appliqué

Find appliqué areas in an embroidery
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Use the Appliqué tab to view and adjust appliqué pieces. The appliqué fabric is shown 
under the embroidery, as it would appear when stitched out. An unlimited number of 
appliqué areas may be added to the work area.  Define appliqué areas and adjust their 
shape, select a fabric and cut holes in the appliqué area.

Decoration Tab

Use the Decoration tab to decorate your chosen background and embroidery with beads, 
sequins, hotfix crystals or nailheads. Choose the desired embellishment in the Decoration 
Selection dialog, then click to place decorations one at a time, or in lines or shapes. Adjust 
the placing and type of decorations in your project using Select Decorations or the 
Context menu. 

Modify Tab

Use the Modify tab to edit and insert stitches, or to select a block of stitches for editing. 
Hide stitches by color or by using the draw range, which will also help with selecting the 
desired stitches. Cut and copy blocks of stitches or whole embroideries and paste to 
attach them to the last visible stitch. Insert new color changes, change the order of colors 
and merge color blocks.

View Tab

Place a single decoration
Draw a line of decorations

Delete the selected decoration or line

View decoration properties

Break up a line of decorations

Select and draw a decoration shape

Place a decoration SuperDesign

Select a single decoration or a decoration line Inset or delete points in a line of decorations

Select a block of stitches

Switch between resize & rescale

Show the selected stitches

Measure a distance

Insert color changes, Stops & stitchesCut, copy or paste a block

Resize or rotate a block

Show and adjust the grid

Open or create a Background
Move or rotate the Background Show and fade the Background

Change the view mode

Choose a different hoop

View the Design PanelRemove the background
Measure a distance
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Use the View tab to adjust the Grid, show and create garment, quilt block and fabric 
backgrounds with the Background Wizard  (PREMIER+™ 2 Embroidery Extra only), view 
appliqué, and change the view mode or hoop.

PREMIER+™ 2 Embroidery Terms and Conventions
For a general overview of terms and conventions, please refer to the PREMIER+™ 2 
Embroidery Guide.

On-screen pointers
The mouse pointer is most commonly shown as an arrow  on the screen. If it is 
positioned over a text box it changes to an I-bar  and you can type, such as the Edit 
Notes dialog box.

When Fit to Rectangle  is chosen, the Draw Rectangle pointer  appears. In the 
ExpressDesign Wizard Crop Picture page, the pointer becomes a double-headed arrow  
when you move the crop lines or a four-headed arrow  when you move the crop area. 
Also, for an Express Embroidery, the pointer becomes an eye-dropper  to pick colors 
from a picture for thread colors or pick a background color.  The pointer also becomes a 
four-headed arrow  when it is over the selection box for one or more embroideries, or 
when Move Background  is selected.

If Zoom To Rectangle , or Zoom In  in a dialog box, is chosen the Zoom In pointer  
appears. If Zoom Out  is chosen in a dialog box, the Zoom Out pointer  appears.

The Box Select pointer , Freehand Select pointer  or Freehand Point Select 
pointer  appears when the associated Select function is chosen.  Add to a selection 
with the Add to Selection  pointer, and remove items from a selection with the Remove 
from Selection  pointer.

There are several pointers indicating functions in the selection box. The Rotate pointer  
appears when the mouse pointer is over the Rotate handle . The cross-hair pointer  
appears when the mouse is over the center of rotation .

The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle .

The Insert Color Change pointer  or Insert Stitches pointer  appears when the 
associated Modify function is chosen. 

The Measure pointer  appears when the Get Length  function is selected.
The pointer becomes the Appliqué Fabric pointer  when adjusting appliqué fabric 
pieces.
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2Backgrounds
Load project backgrounds for use with PREMIER+™ 2 Embroidery Extra in the Background 
Wizard. Use the Background Wizard  to preview the embroideries you have designed 
on a garment, home decor item, fabric or quilt block, or other background.

You can also use the Background Wizard to create new backgrounds for your 
embroideries.

Shortcuts
 View Tab:  
 Keys: Alt, V, W 

Use Realistic 3D  or Life View  to view embroideries and backgrounds in 3D without a grid, hoop or 
selection box. 
Backgrounds are only available in PREMIER+™ 2 Embroidery Extra.

Viewing Backgrounds
Use the Background slider bar to show the garment, quilt or fabric background as On, Off, 
or faded.

Use Move and Rotate Background  to move the garment, quilt or fabric background. 
Click and drag to move the background. Use the background or fabric handle  to 
rotate the background. Right-click to set the background in place and deselect the 
function.

Use Remove Background  to remove the garment, quilt block or fabric background that 
you have placed behind your embroideries.

Load and Create Backgrounds
There are three types of backgrounds used in the Background Wizard: Garment, Quilt 
Block and Fabric. There is a folder for each background type within the special 
Backgrounds folder.

Background On  shows the 
picture in the background.

Click and drag the slider to fade the 
colors in the background picture 

(here by 50%).

Background Off  hides the 
picture. 
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Garment
A garment is treated as a single item, so the garment is shown once on 
the PREMIER+™ 2 Embroidery Extra screen. Use the garment setting for 
a background you want to show once, such as a blouse, a sweater, a 
tote bag or a pillowcase.

Quilt Block
A quilt block is treated as a single item, so the quilt block is shown 
once on the PREMIER+™ 2 Embroidery Extra screen. Use the quilt block 
setting to preview your embellishments to quilt blocks.

Fabric
Fabric is treated as a swatch from a large area of fabric, so it is repeated 
to fill the work area. Use the fabric setting for a background that you 
want to have repeated, such as large home decorating projects 
(curtains, tablecloths or bed covers).

Examples of the garment, quilt block and fabric backgrounds are shown in the 
Backgrounds subfolder of the Sample Guides.
Examples of backgrounds with placement guidelines for monograms are shown in the PREMIER+™ 2 
Monogram Template Guide.pdf in the same subfolder.

Real Size Backgrounds
When you add a new background to your collection, you will need to provide a 
measurement so that it can be matched to the real size of embroideries. The garment, 
quilt block and fabric backgrounds supplied with PREMIER+™ 2 Embroidery have already 
been set to real size.

Choose Background
Use the Choose Background page of the Background Wizard to load an existing 
background or create a new background.

Load an existing background
Create a new background

Use a single garment

Use a single quilt block

Use a fabric background
repeated to fill the work area
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Load an Existing Background
Use the Load Background page of the Background Wizard to select a previously saved 
garment, quilt block or fabric background.

Make a New Background with the Background 
Wizard
Use the Background Wizard to create a new background from a picture of your garment, 
quilt block or fabric.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new 
background.

Select a background file from
the special Backgrounds folder

The background is previewed

Click Finish to load the 
background

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®  
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Rotate and Crop Picture for Garment or Quilt Block
Use the Rotate and Crop Picture page to select the section of the picture for the 
background. If required, adjust the crop lines to select the desired part of the picture.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

 To adjust the crop area, position the mouse over the crop boundary until a double-headed 
arrow  appears, then click and drag to move the boundary line.

 To move the crop area, position the mouse inside the crop boundary until a four-headed 
arrow  appears, then click and drag to move the whole rectangle.

 To redraw the crop area, click and drag outside the crop boundary to draw a new 
rectangle, which can then be adjusted as required.

Rotate and Crop Picture for Fabric
Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the background, and rotate the picture. If required, adjust the crop lines to select 
the desired part of the picture.

Select the whole picture
Use the default crop settings

Adjust the crop lines as desired

Change the angle of the picture

Zoom in and out

Drag crop lines to select area

Drag inside area to move it

Click outside area to redraw it

Show divider lines for tiled area

Zoom in and out

Change the angle of the picture
Use the default crop settings

Select the whole picture
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To see where the four sections of the background are joined, select the Show Divider 
option. Dashed lines show where the tiled sections will be joined. This is useful for 
patterned fabric, to ensure the pattern repeats as desired.

Set Size
Use Set Size to enter a real measurement of the garment, quilt block or fabric so that it will 
be displayed at real size when it is used as the background or appliqué fabric. Fabric is 
measured differently than garments and quilt blocks.

For garments and quilt blocks, the length can be from 1mm to 2000mm. For fabric, the 
length can be from 1mm to 300mm. However, the fabric tile must not be larger than 
300mm x 300mm, so if the line does not span the whole picture it must be shorter than 
300mm.

Set Background Name

Use Set Background Name to save the finished background in a category and give it a 
name. The categories are the folder names you will see when browsing for existing 

Drag the arrows to place the line

Input the length of the line

Select an existing category

Create a new category

Enter a background name
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backgrounds. Garment, quilt block or fabric categories are set separately. Click Make New 
Category to provide the name of a new category.

 Load a Garment in the Background Wizard
1 If required, click File, New Window, 

then click the View tab.
2 Click Change Hoop  and in the 

Hoop Selection dialog box select 
260mm x 200mm - Universal Large 
Hoop 3.

3 Set Orientation to Natural and click 
OK.

4 Click Background Wizard . The 
Choose Background page of the 
Background Wizard appears.

5 Ensure the setting for Background is 
Load Previously Saved and for Type is 
Garment.

6 Click Next. The Load Background 
page of the Background Wizard will appear.

7 Click Load Background .
8 In the Picture Viewer dialog box, browse to the 

folder Garments\Ladies\T-Shirts Round 
Neck\Medium, and all the garments in the folder 
will be shown.
In some views, if you position the arrow pointer over a 
thumbnail without clicking, the name of the garment 
will be shown. The garment is called 'T-Shirt 1 Med 
Green_Lt'.

9 Click the light green t-shirt to highlight it.
10 Click OK to load the t-shirt in the Load Background 

page of the wizard.
11 Click Finish and the t-shirt will be shown in the work area.
12 In the Quick Access toolbar, click Insert .
13 Browse to the folder Documents\Premier+2 \Samples\Premier+Emb\Stitch.
14 Scroll down to the embroidery ’Sunshine Applique Large with Lettering’.
15 Click to highlight the embroidery, then click Open to load it into the work area on the t-shirt.
16 Click Move and Rotate Background .
17 Click and drag the background so that the 

embroidery is at the top of the t-shirt.
18 Click Realistic 3D  to view the 

embroidery on the t-shirt.
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3Appliqué

View and Adjust Appliqué Pieces

Use the appliqué features to view and adjust appliqué pieces. The appliqué fabric is 
shown under the embroidery, as it would appear when stitched out. An unlimited number 
of appliqué areas may be added to the work area.

The Appliqué tab is only available in PREMIER+™ 2 Embroidery Extra.
The appliqué features show how a fabric would be placed. They do not alter the stitches. To create new 
appliqué designs, or add a border, use the ExpressDesign Wizard or PREMIER+™ 2 Create. To add extra 
stitches and stop commands to an existing embroidery, use the Modify tab or PREMIER+™ 2 Modify. To 
place appliqué fabrics at a precise command it may be easier to navigate through the design in 
PREMIER+™ 2 Modify.
PREMIER+™ 2 Embroidery includes many Fonts, SuperDesigns and Frames with appliqué 
fabric, stitches and Stop Commands. The fabric and some stitch types may be adjusted 
using the Context menu. To change the fabric pattern position, create holes or alter the 
outline, you must Fix as Stitches before using the features on the Appliqué tab.

Any fabric background may be used as appliqué, and any number of different appliqué fabrics may be 
used, as desired. Ensure that the correct design is selected before adding appliqué. Use the Tab key to step 
through the embroideries.

Appliqué Piece
Use the Appliqué Piece functions to add appliqué fabric to an existing design with 
appliqué areas, and to adjust appliqué areas within a design.

Change the Fabric in an Appliqué Embroidery
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop 

Size to 100mm x 100mm - Universal Square Hoop 1. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\Premier+2\Samples\Premier+Emb\Stitch 

load the embroidery 'Night Time_applique'.
5 Click the Appliqué tab.
6 Click Next Piece . The points for the appliqué area for the moon are 

highlighted.
All of the appliqué functions are now available.

7 Click and drag the square zigzag fabric handle . The fabric for the 
moon moves.
Use the fabric handle to move the origin point (center of design) of a tiled fabric.

Audition a fabric for 

Delete an appliqué piece
Insert and Delete points in the outline of an appliqué area
Select an appliqué area, or move to another areaDefine the outline of an appliqué area

Cut a hole in an appliqué area

the appliqué

Find appliqué areas in an embroidery



PREMIER+™ 2 Embroidery Extra   Appliqué              13

This handle  is only available for fabric tiles; you cannot rotate quick Appliqué or Pictures.
8 Click and drag the round handle. The fabric for the moon rotates.

The fabric rotates around the fabric handle (the origin point of the fabric tile).
9 Click Select Fabric  or choose it in the Context menu. The Appliqué Selection dialog box opens.
10 To change the fabric, click Fabric in Appliqué Type, then click Load Previously Saved Fabric  and 

choose another fabric.
11 Click OK to close the Appliqué Selection dialog box.

If there is more than one appliqué fabric in the design, click Next Piece  to view the second fabric

Appliqué Outline
Use the Appliqué Outline  functions to draw or place points to define a line of any 
shape to create an appliqué outline. Select a Color Command or Stop Command to start 
the appliqué piece from, then draw the outline. Use Freehand Tablet Appliqué Outline  
to draw a line of any shape to create an appliqué outline. Use Freehand Point Appliqué 
Outline  to place points to define a line of any shape to create an appliqué outline. 

Appliqué Hole
Use the Appliqué Hole  functions to draw or place points to define a line of any shape 
to create a hole within the selected appliqué area. Select the desired Appliqué Piece so its 
points are displayed, then draw the hole. Use Freehand Tablet Appliqué Hole  to draw a 
line of any shape to create a hole within the selected appliqué area. Use Freehand Point 
Appliqué Hole  to place points to define a line of any shape to create a hole within the 
selected appliqué area. 

Express Appliqué
Use Express Appliqué  to automatically find appliqué stitches within an existing 
embroidery, and apply an appliqué fabric to them.

Multiple appliqué areas can be detected in the same design. To add appliqué to part of a project, select the 
desired embroidery before using Express Appliqué.

Select Piece
Use Select Piece  to select an Appliqué Piece to alter its shape and preview or adjust its 
fabric. Click Select Piece , and then click the desired Appliqué Piece.

Use Next Piece   and Previous Piece  to select the next or previous Appliqué Piece in 
the stitchout order.

Next  Piece and Previous Piece will select an appliqué piece even if no appliqué piece is currently selected.
Use Insert Points  to add new points into the currently selected Appliqué Piece, and 
Delete Points  to delete points from the currently selected Appliqué Piece. Use Delete 
Piece  to delete the currently selected Appliqué Piece with its outline.

Select Appliqué Pieces
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - 

Universal Square Hoop 1. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert   and in the folder 

Documents\Premier+2\Samples\Premier+Emb\Stitch load the embroidery 'Blocks_fixed'.
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4 Click the Appliqué tab.
Note that the Select Piece icon  is available. This indicates that there is at 
least one appliqué piece in the embroidery.

5 Click Select Piece , then click the A block. The points outlining the 
appliqué appear.

6 Click and drag one of the points to change the shape of the appliqué.
Note that you can change the shape of the appliqué area, but this does not 
affect the satin border.

7 Click Undo  to return to the original shape.
You can also use the Fabric Handle  to change the position and rotation 
of the fabric.

8 Click Next Piece . The letter C block is now selected.
9 Click Previous Piece  twice. First the A and then the B are selected.
10 Click Delete Piece . The appliqué fabric for the B block is removed, leaving the border lines.

Select Fabric
Use Select Fabric  to audition a fabric for the selected appliqué piece in the Appliqué 
Selection dialog box. Select the desired appliqué piece, then click Select Fabric  and the 
Appliqué Selection dialog box appears. 

Appliqué Selection
Use the Appliqué Selection dialog box to change and add appliqué fabrics.

You can only change the pattern position of the appliqué pieces for fixed embroideries. To change the 
appliqué fabric pattern position for lettering, SuperDesigns and Frames, fix as an embroidery. To change 
the fabric or angle only, or the appliqué piece margin, use the context menu.
Use the Appliqué Selection dialog box to select a fabric or picture to use for appliqué. Click 
OK to use the selected appliqué fabric.

Appliqué Type
Choose an appliqué type (or simply select one of the recently used swatches). Select from:

Select a Quick Color & texture

Choose an appliqué type

Choose a system fabric

Load an individual picture 

Preview the appliqué fabric

Reuse a recent fabric

or add a new one

for printed appliqué
Set the appliqué border margin 
Match pre-cut piece and outline

Print a sheet of appliqué fabric
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 Quick: Select a color and texture for your fabric. In the PREMIER+™ 2 QuickFont Wizard 
only the Quick Appliqué options are available.

 Fabric: Select a background fabric, or add a new background fabric from a picture. Set the 
angle for the fabric.

 Picture: Create an individual non-tiling appliqué from a picture. For instance, use a photo 
for a printed appliqué memory piece.

 Cut-out: Create an appliqué placement line as a guide to where the fabric should be cut to 
form a hole; for example, for reverse appliqué.

Background Picture Viewer
Use the Picture Viewer to select a fabric from the system fabrics, or from My Fabrics.

Export Appliqué
Use Export Appliqué Pieces  in the File menu to save or print appliqué outlines.

Choose a fabric folder

Scroll to view more fabrics

Click to select a fabric

Scroll to view more folders

Change the icon size

Load the selected fabric

Export a SVG, DXF or FCM file for use in a fabric cutter

Use 2 or 4 cutwork needles

Add secure points for fabric stability

Export a .vp3 or .vp4 stitch file

Print as an outline template for cutting out

Print onto printable fabric or an iron-on transfer

Save as a PNG fabric images for a custom layout
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4Decorations
Decorate your chosen background and embroidery with beads, sequins, hotfix crystals or 
nailheads. Choose the desired embellishment in the Decoration Selection dialog, then 
click to place decorations one at a time, or in lines or shapes. Adjust the placing and type 
of decorations in your project using Select Decorations or the Context menu. 

Decoration

Center or Line Placement
Center or Line placement stitches are created automatically for decorations according to 
the options set in PREMIER+™ 2 Configure, which may be altered when you export the 
embroidery. Alternatively, create a crystal transfer template (rhinestone template) for 
automated cutters for pressing hotfix crystals and nailheads directly on your work, using 
File, Export Decoration Template.

Center placement stitches are recommended when most decorations are individual and 
symmetrical. Line placement stitches are recommended when most decorations are 
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Decorations are placed on top of the background, appliqué and embroidery. 
The Decoration tab is only available in PREMIER+™ 2 Embroidery Extra.

Place a single decoration
Draw a line of decorations

Delete the selected decoration or line

View decoration properties

Break up a line of decorations

Select and draw a decoration shape

Place a decoration SuperDesign

Select a single decoration or a decoration line Inset or delete points in a line of decorations

Select measurement units for the decoration template

Export decoration template as SVG, DXF or FCM image file

Create separate templates for different decoration types

Add stitches to align the template with the embroidery
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Adding Decorations
Add beads, sequins, crystals or nailheads to your project as individual decorations with 
Place Individual , or as lines of decorations with Draw Line  or Draw Shape . Insert 
a special SuperDesign with decorations using Decoration SuperDesign .

Decorations are added as a decoration subdesign or to an existing decoration subdesign if 
one is selected.

Use Select Decoration  and Properties  or the Context menu to make changes to the line of 
decorations.

Place Individual Beads on an Embroidery
1 Load the desired background and embroideries.
2 Position the embroideries as desired.
3 Click the Place Individual icon . The Decoration Selection dialog box will appear.
4 Click to select the desired bead type and material.
5 Click the Color drop-down menu and use the Colors dialog box to select a color, or choose a color in 

the Quick Colors.
6 In Size, select the desired bead size.
7 Choose the angle of rotation of the bead in Angle.
8 Click OK to close the Decoration Selection dialog box.

The cursor changes to the Insert cursor  to show that you may place beads.
9 Click in the work area to place the bead. Each click will place one bead.

Click and drag will have no effect while placing beads. Use Undo to remove the last bead.
10 When you have placed all the beads as desired, right-click and select "Finish placing individual" in the 

Context menu to end.
11 Repeat the process to place more beads as desired.
12 Use File, Export Decoration Template  to create a crystal transfer template (or rhinestone 

template) for pressing hotfix crystals and nailheads directly onto your work. 

Draw Line
Use Draw Line  to place lines of decorations on your project. Select a bead, sequin, 
crystal or nailhead using your preferred material, size and color in the Decoration 
Selection dialog, and then draw your line.

Select the angle of Rotation, and choose whether the line of decorations will follow the line drawn (Follow 
Line), or if they will use the angle set in rotation (Stepped).
Use Freehand Tablet Line  to click and drag to draw a line of decorations. Use Freehand 
Point Line  to place points to draw a line of decorations.

Draw Shape
Use Draw Shape  to draw a shaped line of decorations on 
your project, using the shape currently selected in the gallery 
of preset shapes. 

Once placed, a decoration shape is treated as a line of decorations.
Click the drop-down arrow to the right of the shapes gallery, 
and scroll to select the desired shape in the list. Click Draw 
Shape , and select a decoration type in the Decoration Selection dialog. 
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The shape is shown as a red and cyan line, with 
handles to resize, flip and rotate the shape. To move 
the shape, click and drag inside the shape.  

Resize the shape with the resize handles on the 
corners. Hold down Ctrl as you click and drag to retain 
the current proportions of the shape.

When the shape is sized and positioned as desired, 
right-click and select "Finish placing shape" in the 
Context menu to create the shape.

Decoration SuperDesign
Use Decoration SuperDesign  to 
insert a Decoration SuperDesign into 
your current project. Change the size, 
color and decoration type to 
complement your project.

Click Decoration SuperDesign  and in 
the File Viewer dialog box, scroll down 
and click to highlight the desired design. 
Click Open to load the decoration 
design.

Editing Decorations
Use Select Decoration  to select single decorations positioned with Place Individual , 
or lines placed with Draw Line  or Draw Shape . You can adjust or delete individual 
decorations, and insert or delete points along lines of decorations, or break up or delete 
complete lines of decorations.

Alternatively, for a quick and easy way to change decorations, right-click a decoration subdesign and 
select all decorations of a specific type from the Context menu. The Decoration Selection dialog box opens.
Use the Context menu to change decorations when in other PREMIER+™ 2 Embroidery tabs.

Resizing and Reshaping Decorations and Lines
1 Click Decoration SuperDesign  and in the File Viewer select ’Bear Lg 1’ in the Faces folder. Click 

Open to load it in the work area, then close the File Viewer.
2 Click Select Decoration , then click one of the beads in the bear’s ears. 

This selects a single bead, as the bead has been placed individually.
Select Decoration enables you to change individual beads and lines in a 
Decoration SuperDesign or other subdesign.

3 Click one of the beads in the outline of the bear’s face. This bead is part of 
a line of beads.

4 Right-click, and select "Finish selection decoration" in the Context menu.
5 Click and drag one of the green corner handles for the Decoration 

SuperDesign to make it larger.
The beads placed individually become more widely spaced. If desired, place individual additional 
decorations, or adjust the size. The line forming the outline of the bear’s face shows an increased 
number of beads as the circle enlarges.
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When a line or shape is enlarged, the number of decorations increases. It decreases as the line or shape is 
made smaller.

Inserting and Deleting Points and Decorations
Use Insert Points  to add new points to the currently selected line of decorations. Use 
Delete Points  to delete points from the currently selected Line of Decorations. Use 
Delete Selection  to delete the currently selected individual decoration, or line of 
decorations. Use Break Up Line  to break up the currently selected line of decorations 
into individual decorations for independent editing.

Use Break Up Line to create a line or shape with alternating colors. Once the line or shape has been broken 
into individual decorations, use Ctrl and click to select alternate decorations, then right-click the selected 
decorations and select Properties in the Context menu to change their color.

Decoration Selection
Use the Decoration Selection dialog box to choose beads and sequins.

Decorations
The following types of decorations are available, in a variety of colors, materials and sizes:

Shape Size (in mm) Shape Size (in mm)

Round 4, 5, 6, 7, 8, 9, 10 Crystal 
Rectangular

3, 4, 5, 6, 7, 8, 9, 10

Oval 4, 5, 6, 7, 8, 9, 10 Crystal Round 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 
4.0, 4.5, 5.0, 6.0, 7.0, 8.0, 
9.0, 10.0, 12.0

Seed 1.0, 1.5, 2.0, 2.5, 3.0 Crystal Square 3, 4, 5, 6, 7, 8, 9, 10

Bugle 4, 5, 6, 7, 8, 9, 10 Crystal 
Triangle

3, 4, 5, 6, 7, 8, 9, 10

Choose a decoration shape and material

Preview the decoration

Choose a color

Select the decoration size

Set the decoration angle

Set spacing & angle for
lines of decorations
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The Preview shows the decorations in two orientations so you can visualize their placement accurately.

Sizes for Crystal Round and Nailhead Round Decorations
1.0, 1.5 (SS 3-4, PP 7-10), 2.0 (SS 5-6, PP 11-15), 2.5 (SS 7-9, PP 16-20), 3.0 (SS 10-12, PP 21-24), 3.5 (SS 
13-14, PP 25-28), 4.0 (SS 15-17, PP 29-32), 4.5, 5.0 (SS 18-22), 6.0 (SS 23-28), 7.0 (SS 29-33), 8.0 (SS 34-
38), 9.0 (SS 39-42), 10.0 (SS 43-45), 12.0 (SS 46-50)
When purchasing round crystals, nailheads or rhinestones, manufacturers’ sizes may use the term SS 
(stone size) or PP (pearl plate).

Bugle Twisted 4, 5, 6, 7, 8, 9, 10 Nailhead 
Diamond

3, 4, 5, 6, 7, 8, 9, 10

Sequin Cup 2, 3, 4, 5, 6, 7, 8, 9, 
10

Nailhead Heart 3, 4, 5, 6, 7, 8, 9, 10

Sequin Flat 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead Petal 3, 4, 5, 6, 7, 8, 9, 10

Sequin Flower 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Rectangular

3, 4, 5, 6, 7, 8, 9, 10

Sequin Heart 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Round

1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 
4.0, 4.5, 5.0, 6.0, 7.0, 8.0, 
9.0, 10.0, 12.0

Sequin 
Snowflake

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead Star 3, 4, 5, 6, 7, 8, 9, 10

Sequin 5-Point 
Star

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Teardrop

3, 4, 5, 6, 7, 8, 9, 10

Sequin 6-Point 
Star

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Triangle

3, 4, 5, 6, 7, 8, 9, 10

Crystal Oval 3, 4, 5, 6, 7, 8, 9, 10
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5ExpressDesign Wizard
Use the ExpressDesign Wizard to create new embroideries automatically from pictures. 
There are three embroidery types that can be created in the ExpressDesign Wizard: 
Express Embroidery, Express Trace and Express Border.

The ExpressDesign Wizard is only available in PREMIER+™ 2 Embroidery Extra.

Create an ExpressDesign Embroidery
1 Click the Wizards tab.
2 In the ExpressDesign drop-down list choose ExpressDesign into Hoop  or ExpressDesign into 

Rectangle .
ExpressDesign into Hoop creates an embroidery that is a best-fit to the currently selected hoop. 
ExpressDesign into Rectangle creates an embroidery that is a best-fit to a rectangular area you draw.

3 In the Choose Design Type wizard page, select the desired design type from: Express Embroidery, 
Express Trace, or Express Border, then click Next.

4 Select a picture in the Choose Picture page.
5 Step through the rest of the ExpressDesign Wizard. 
6 When you Finish, the new embroidery will be placed in the center of the hoop, or where you drew the 

rectangle, fitting proportionally, depending on the picture shape. 
7 Use Save  to keep the new embroidery in multipart .vp4 format.
8 Use Export  to save in other formats, and optimize for stitching.

ExpressDesign into Hoop and ExpressDesign into Rectangle
Use the ExpressDesign into Hoop  option to create a new embroidery in the 
ExpressDesign Wizard that is a best-fit to the currently selected hoop and orientation. 

If desired, click Change Hoop  and choose a different hoop size before using ExpressDesign into Hoop.

Use the ExpressDesign into Rectangle  option to create a new embroidery in the 
ExpressDesign Wizard that is a best-fit to a rectangular area you draw.

If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears. 
Then click ExpressDesign into Rectangle again.

Express Embroidery Express Trace Express Border

Create a new embroidery by 
converting color areas in a picture 
to fill and satin areas, outlining it 
with running stitch or satin line.

Create a new embroidery by 
tracing outlines in a picture.

Create a new embroidery or 
appliqué design by creating 
borders around shapes in a 
picture.
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Choosing and Optimizing Pictures for the 
ExpressDesign Wizard
If you wish to modify a picture before using it in the ExpressDesign Wizard, you will need 
to use a picture editor. If you have it available, use PREMIER+™ 2 PhotoStitch to adjust your 
picture, save it with a new name, then use the new picture in the ExpressDesign Wizard.

It is recommended to keep your original picture in case you wish to adjust it again with different options.

General Considerations
The ExpressDesign Wizard works best with pictures that have well defined color areas and 
outlines.

You may wish to tidy up a picture before using it in the ExpressDesign Wizard, by deleting 
elements that are not required. Some pictures have stray or irregular lines and shapes that 
are not part of the main picture. For example, lines that add emphasis or suggest 
movement, speech or thought bubbles, decorative symbols, undesirable text, date marks.

Picture Proportions
To fill the hoop or rectangle, the picture proportions should be similar to the proportions 
of the hoop or rectangle you draw. The Rotate and Crop Picture page of the ExpressDesign 
Wizard can be used to crop the picture to the desired proportions.

Cleaning a Picture
Some pictures may have random marks, speckles or excess details. If desired, use an image 
editor to clean up your picture before importing it. For example, you may have an outline 
in a picture that is serrated on one side. Smoothing such an outline will usually give better 
results, particularly from Express Trace and Express Border.

Enhancing Details
The significance of details in a picture is dependant on the overall size of the picture after 
it is cropped, so small details are more significant in a small picture. Also, small details are 
enlarged as the size of the created embroidery increases, so extra detail may appear if you 
simply make a larger embroidery with the same picture.

However, very small details in a picture may sometimes be ignored, as they may not have 
enough significance to be created as an area or outline in the embroidery. To enhance 
details, select Picture Options in the ExpressDesign Wizard, ensure Expand Pixel-Thin Lines 

Before cleaning: the line has shading serrations and 
there are dust marks from the scan

After cleaning: the line is smooth and the dust marks 
have been removed
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is selected and set the Area Sensitivity to High. If this does not work, either enlarge the 
details in your picture editor, or, for outline details, connect small details together so they 
are created as a single outline.

Thick lines in a picture may be created as satin border when you would prefer regular 
outlining for a more detailed effect. To automatically reduce thick outlines, select Reduce 
Thick Lines in the Picture Options.

Pictures for Express Embroidery
Many types of picture are suitable for creating an Express Embroidery. The primary factor, 
however, is to use pictures with well defined color areas and/or well defined outlines. 
Pictures that have complex color areas, such as photographs or scanned pictures that 
have not been cleaned up, can be used to create an Express Embroidery, but you may not 
get the best result unless some time is spent modifying the original picture.

Connected Outlines
When editing or creating a picture, check how the outlines are connected to each other 
and, where possible, look for unobtrusive places to connect outlines. When the outlines 
are more connected, there will be fewer movement stitches in the final embroidery and 
the embroidery will also stitch out more efficiently. Also, for smaller embroideries, adding 
connections between outlines will be less noticeable and will also prevent small sections 
of stitches that might be less secure.

Stippled Pictures
Stippled pictures are not suitable for creating an Express Embroidery. This is because the 
color areas approximate solid colors with dots of two or more colors in a stipple pattern.

Stippled pictures may be used for Express Trace or Express Border, if they have solid 
outlines or areas that can be extracted using Monochrome Threshold.

Choose Design Type
Convert color areas

Trace picture outlines

Create borders or appliqués

to satin and fill

around shapes in a picture
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Choose Picture

Use the Choose Picture page to select the picture you wish to convert to a design. Select a 
picture from clipart, or one you have previously scanned or created in an image editor. 
Alternatively, paste a captured picture, or one from social media.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

PREMIER+™ 2 Embroidery Extra also includes additional clipart, which may be used in the 
ExpressDesign Wizard. The additional clipart is installed to 
Documents\Premier+2\Samples\Premier+Emb\Pics2.

Rotate and Crop Picture

If required, rotate the picture to any angle from 0 to 359 degrees. For example, this is 
useful for straightening scanned pictures.

Select a picture file on
your computer

Paste a copied picture

Import a file from a
scanner or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®

Change the angle of the picture

Zoom in and out

Select the whole picture

Use the default crop settings

Adjust the crop lines as desired
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When the picture is rotated between the 90 degree steps, the picture is made larger and 
the detected background color is added. If there is no distinctive background color, white 
is used.

Use the Crop function to select the section of the picture that is to be used to create the 
design. The picture is automatically cropped to remove excess background color. If 
required, adjust the crop lines to select the desired part of the picture.

Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.

Outline Finder and Expander

The Outline Finder and Expander page of the ExpressDesign Wizard only appears if you 
are creating an Express Trace design. If the picture consists of mainly solid color areas, use 
this page to create outlines appropriate for tracing.

Find Outlines
Select this option to find the outlines in your picture and show them in the preview area.

Find Outlines looks for distinctive boundaries between color areas in the picture. Pictures that have 
gradual color changes, such as photographs or previously scanned pictures saved in JPEG format, may not 
have strong color boundaries that can be detected by Find Outlines.

Expand
This is only available when Find Outlines is selected. Use this option to increase the 
thickness of outlines that have been found, by adding up to 5 pixels on each side of the 
lines. It is initially set to 1. Lines are traced down the center by Express Trace, so setting 
Expand to at least 1 will allow curves to be traced more smoothly and continuously.

If desired, use higher Expand values to merge outlines when parallel outlines are close 
together. Alternatively, you may be able to exclude unwanted lines by using Monochrome 
Threshold on the next page.

Find the outline in the picture

Increase the thickness of the line

Preview your changes
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Monochrome Threshold

The Monochrome Threshold page of the ExpressDesign Wizard appears if you are creating 
an Express Trace or Express Border design.

The Monochrome Threshold turns all shades or colors in the picture into either black or 
white. It acts on the whole picture. The Monochrome Threshold creates defined areas that 
are suitable for creating the final designs.

Interior details, within enclosed shapes in the picture, will not be preserved when creating Express Border.

Express Embroidery Options
Choose Thread Colors

The Choose Thread Colors page of the ExpressDesign Wizard only appears when you are 
creating an Express Embroidery. Use the Choose Thread Colors page to match thread 
colors to colors in the picture, to set the number of colors, and to choose the color order. 
Select whether or not to keep the background and, if desired, pick a different background 

Adjust the color sensitivity

Original picture

Preview monochrome version

Select a Thread Range

Delete all colors

Move colors up & down the list
Change a thread color

Remove the background color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list

Pick a background color from the picture
Enhance detail in the picture

Set the number of colors
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color. Optionally, choose whether or not to expand thin lines and set the sensitivity to 
small areas in the picture.

The maximum Number of Colors is 256. For pictures with less than 256 colors, the 
maximum is the total number of colors in the picture.

The color list shows the colors that have been automatically selected. The colors are 
picked to give the closest representation of the original picture with the current Number 
of Colors. Each time the number of colors is changed, this list is updated. Sometimes, 
when the Number of Colors is reduced to a low number, colors will be chosen that are 
averages of two or more prominent colors in the picture. This can give a posterized 
appearance to the Reduced Colors Preview.

When more than one color in the picture is matched to the same thread color, the number of color changes 
in the final embroidery is reduced.

Picture Options

Black Lines
There are three options for handling black lines in your picture.

Select Expand Pixel-Thin Lines to make black lines thicker, to 
prevent broken lines where pixels join at corners. This option is 
on by default, to ensure that outlines in the picture are 
continuous.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Use High sensitivity to increase the detail extracted from the picture. This is useful, 
for example, when facial details are ignored at Medium sensitivity.

Fabric and Stitch Type Options

The Fabric and Stitch Type Options page of the ExpressDesign Wizard only appears when 
you are creating an Express Embroidery. Use the Fabric and Stitch Type page to choose the 
fabric that the design will be stitched onto, and the preference for fill areas or satin areas.

Choose a fabric type

Add underlay to the design

Create more satin or
more fill areas

View the design information

Preview the embroidery

Place on the work area
Make further edits
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Fabric Advisor
Choose the fabric on which the design will be stitched. Adjustments are made in the 
embroidery creation process to suit the chosen fabric, such as the type of underlay chosen 
for individual areas of satin or fill.

Choose Design Underlay to provide stitching below the whole embroidery, in addition to 
automatic underlay in different areas.

When Design Underlay is turned off it is easier to convert areas to lightly stitched specialty fills in 
PREMIER+™ 2 Modify or PREMIER+™ 2 Create .

Express Trace Options

The Express Trace Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Trace design. Select whether lines in the picture will be traced with a 
combination of double and running stitch, a combination of triple and running stitch, or 
satin line. Also select the thread color.

Express Border Options

Choose a stitch line type

Set the properties for the line

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Preview the embroidery

Choose a stitch type 
for the border
Set the properties for the border

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Add appliqué to the design
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The Express Border Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Border design. Use the Border Options to select the type of stitching 
used for the borders, and to choose the thread color.

Select the type of border to create around areas of the picture from one of the following: 
Satin Line , Running Stitch , Double Stitch , Triple Stitch , Motif Line .

Appliqué
Select Appliqué  to use appliqué within the borders of the design.

 Click Select Fabric to change the appliqué fabric. 
 Click Appliqué Options to select the appliqué type.

When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Appliqué Options
Use the Appliqué Options dialog box to select an 
Appliqué Method for appliqué placement, and set the 
Appliqué Piece Margin. When appliqué is created from 
a border shape, additional stitches are added at the 
beginning of the embroidery for placing appliqué 
fabric. Use these options to determine how these 
stitches are added.

Using Express Embroidery, Trace and Border
Create a Happy Sun Embroidery

1 If required, click File, New Window.
2 In the Quick Access toolbar click 

Change Hoop  and set the hoop 
size to 100mm x 100mm - Universal 
Square Hoop 1. Click OK.

3 Click the Wizards tab.
4 Click the drop-down arrow beneath 

the ExpressDesign Wizard icon , 
then click ExpressDesign into 
Hoop . The Choose Design Type 
page of the ExpressDesign Wizard 
appears.

5 Leave Create Express Embroidery 
selected and click Next. The Choose 
Picture page of the ExpressDesign 
Wizard appears.

6 Click Load a Picture  and the picture 
viewer will appear.

7 Browse to the folder Documents\Premier+2\Samples\Premier+Emb\Pics.
8 Click 'Happy Sun.png' and click OK.

The picture is loaded onto the Choose Picture page, with its name shown below the preview area.
9 Click Next and the Rotate and Crop Picture page will appear. No rotation or adjustment of the crop 

lines is needed, so click Next and the Choose Thread Colors page will appear.
10 There are 7 colors automatically picked for this picture. For this picture, it is recommended to use all 7 

of the detected 7 colors, so no adjustment is needed.
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For other pictures, you may wish to increase or decrease the number of colors picked. Click the up and 
down arrows next to the number, or click in the box and enter the desired number.

11 If the colors in the color list are not set 
to Robison-Anton Rayon 40, click the 
drop-down arrow at the end of the 
Change All To box and select Robison-
Anton Rayon 40.

12 Ensure the Automatically Remove 
Background Color checkbox is selected 
to remove the white background.
In Background Color, the large white 
square shows that white is the detected 
background color. When Automatically 
Remove Background Color is selected, the 
background color is replaced by a check 
pattern in the Thread Color Preview. This 
shows where there will be no stitches.

13 Click the Picture Options button.
14 In the Picture Options dialog, ensure that Expand Pixel-Thin Lines is selected in Black Lines.
15 In Area Sensitivity, ensure that the 

setting is Medium.
16 Click OK.
17 Click Next. The Fabric and Stitch 

Options page appears.
18 Leave fabric as Woven.
19 Select Design Underlay.

Leave Design Underlay deselected 
(unchecked) if you plan to alter stitch 
types after creation.

20 Move the Preferred Stitch Type slider to 
4. This will use fill for the sun’s face, and 
satin for the sun’s rays.

21 Click Refresh Preview. The embroidery 
shown in the preview area is updated.

22 Click Finish. The Happy Sun embroidery appears on the work area.

Create a Happy Sun Express Trace
1 If required, click File, New Window, then click the Wizards tab.
2 Click the drop-down arrow beneath the ExpressDesign Wizard icon , and then click ExpressDesign 

into Rectangle . The pointer changes to the draw rectangle pointer .
3 Starting at the corner of a grid square, 

click and drag to draw a square that is 
seven by seven grid squares.
If the rectangle is wrong click Cancel 
when the Choose Design Type page 
appears and return to step 2.

4 Release the mouse button and the 
Choose Design Type page of the 
ExpressDesign Wizard will appear.

5 Select the Create Express Trace option.
6 Click Next and the Choose Picture page 

will appear.
7 Click Load a Picture  and the picture 

viewer will appear.
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8 Browse to the folder Documents\Premier+2\Samples\Premier+Emb\Pics.
9 Click 'Happy Sun.png', the click OK. The picture will be loaded onto the Choose Picture page.
10 Click Next and the Rotate and Crop Picture page will appear. No rotation or cropping is required, so 

click Next and the Outline Finder and Expander page will appear.
11 The picture already has outlines that can be used, so ensure the Find Outline option is not selected 

(unchecked). Click Next and the Monochrome Threshold page will appear.
12 Set the Monochrome Threshold to less than 75, so that only the outlines 

show in the preview.
13 Click Next and the Express Trace Options page will appear.
14 Ensure Double Trace is selected.

Double Trace traces lines in the picture with a combination of double stitch 
and running stitch. Quadruple Trace creates a bolder effect by using a 
combination of triple stitch and running stitch.

15 Click the Thread Color icon  and set the thread color to Sulky Rayon 40 
1124 (Sun Yellow). The preview shows the chosen thread color.

16 Click Finish and the Happy Sun embroidery will appear on the work area, 
where the rectangle was drawn.

Create an Umbrella Border
1 If required, click File, New Window, then click Change Hoop  in the Quick Access toolbar.
2 Set the hoop size to 100mm x 100mm - Universal Square Hoop 1.  Click OK.
3 Click the Wizards tab.
4 Click the drop-down arrow beneath the ExpressDesign Wizard icon , then click ExpressDesign into 

Hoop. The Choose Design Type page of the ExpressDesign Wizard appears.
5 Select the Create Express Border option and click Next. The Choose Picture page appears.
6 Click Load a Picture  and the picture viewer will appear.
7 Browse to the folder Documents\Premier+2\Samples \Premier+Emb\Pics.
8 Click 'Umbrella.png', then click OK. The picture will be loaded onto the Choose Picture page.
9 Click Next and the Rotate and Crop 

Picture page will appear. 
10 Click Select All.

This will create a small margin around 
the embroidery, so that it does not touch 
the edge of the hoop area.

11 Click Next and the Monochrome 
Threshold page will appear.

12 Set the Monochrome Threshold to 244 
or more, so that all of the colored areas 
in the umbrella are black.
This creates a clear shape to use for the 
border. If a lower number is used, extra 
lines may appear, or there may be gaps.

13 Click Next and the Express Border 
Options page will appear.

14 Ensure that Satin Line is selected as the Border Type.
15 Click Stitch Options. The Satin Line dialog box will appear.
16 Ensure that Width is set to 2.0mm, that Density is set to 4, and that 

Underlay is selected, then click OK.
17 Click the Thread Color icon  and set the thread color to Robison-

Anton Rayon 40 2259 (Wild Pink). Click OK. the umbrella is now pink.
18 Ensure that Appliqué  is selected and click Select Fabric.
19 In the Quick Colors section of the Appliqué Selection dialog box, 

choose a fabric and color that will match the satin line for the border.
Click the arrow to the right of the Quick Colors to view more colors.

20 Click Finish to place the embroidery on the work area.
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6PhotoStitch Wizard
Use the PhotoStitch Wizard  to create new embroidered PhotoStitch portraits 
automatically from photos, including photos from social media sites. Also browse to a 
photo on your computer, or acquire pictures from a digital camera or scanner.

The PhotoStitch Wizard is available only if you own PREMIER+™ 2 Embroidery Extra.
The Color PhotoStitch, Sepia PhotoStitch, Monochrome PhotoStitch and Color Tile PhotoStitch options in 
the PhotoStitch Wizard are available only if you own PREMIER+™ 2 ULTRA. Further information can be 
found in the PREMIER+™ 2 PhotoStitch Reference Guide. The full PREMIER+™ 2 PhotoStitch module is 
available only if you own PREMIER+™ 2 ULTRA.

Color PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating a 
randomized pattern of stitches, using multiple threads for a full color 
result.

Color PhotoStitch works best when using pictures with a good color 
range, and a well defined, differently colored or transparent, 
background.

Sepia PhotoStitch Embroidery
Create a sepia embroidery from an old sepia or black and white 
picture, or create a sepia effect embroidery from a color picture, to 
give a heritage look, similar to old photos. PhotoStitch generates a 
randomized pattern of stitches, using sepia colored threads.

Sepia PhotoStitch works best when using pictures with good 
contrast, and a well defined or transparent background.

Monochrome PhotoStitch Embroidery
Create a PhotoStitch embroidery from a black and white photo, 
generating a randomized pattern of stitches, using threads in 
grayscale color ways

Monochrome PhotoStitch works best when using pictures with 
good contrast, and a well defined or transparent background.

Color Tile PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating 
small blocks of stitches in varying shapes with a tiled effect, using 
multiple threads for a full color result. PhotoStitch automatically 
generates tiled blocks of stitching in the selected colors. Select from 
diamond, square or hexagon shaped blocks.

The color tile method is ideal for achieving artistic, impressionistic 
embroideries. Color Tile PhotoStitch Embroidery works best when using pictures with 
good contrast, and a well defined or transparent background.
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Linear PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color or monochrome 
photo, generating a linear pattern of stitches, or a Maze or Spiral 
artistic effect, using one thread for a single color result. There are six 
effects available.

Linear PhotoStitch works best when using a photo with good 
contrast on the face, and without areas of deep shadow. If the 
background is transparent, parallel scan lines will be created.

PhotoStitch Wizard
Select the PhotoStitch Wizard in the Wizards tab to create an embroidery from a photo. 

PhotoStitch Into Hoop
Use the PhotoStitch Into Hoop  option to create a new embroidery in the PhotoStitch 
Wizard that is a best-fit to the currently selected hoop. 

If desired, click Change Hoop  and choose a different hoop size before using PhotoStitch Into Hoop.

Click PhotoStitch Into Hoop  and the Choose Embroidery Type page of the PhotoStitch 
Wizard will appear. Choose the desired design type, then choose a picture and step 
through the rest of the PhotoStitch Wizard. When you Finish, the new embroidery will be 
placed in the center of the hoop. Depending on its shape, it will fit in the hoop vertically 
and/or horizontally. Use Save  to keep the new embroidery in multipart .vp4 format, 
together with any other embroideries in the work area, and use Export  to save in other 
formats, and optimized for stitching.

Shortcuts

 Wizards Tab: 
 Keys: Alt, W, P, H

PhotoStitch Into Rectangle
Use the PhotoStitch Into Rectangle  option to create a new embroidery in the 
PhotoStitch Wizard that is a best-fit to a rectangular area you draw.

Click PhotoStitch Into Rectangle  and the mouse pointer will change to the draw 
rectangle pointer . Click and drag on the work area to draw a rectangle of the desired 
size. When you release the mouse button, the Choose Embroidery Type page of the 
PhotoStitch Wizard will appear.

If the rectangle is wrong and you wish to try again, click Cancel when the PhotoStitch Wizard appears. 
Then click PhotoStitch Into Rectangle again.
Choose the desired design type, then choose a picture and step through the rest of the 
PhotoStitch Wizard. When you Finish, the new embroidery will be placed where you drew 
the rectangle, and will fit the rectangle proportionally, depending on the picture shape. 
Use Save  to keep the new embroidery in multipart .vp4 format, together with any 
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other embroideries in the work area, and use Export  to save in other formats, and 
optimized for stitching.

Shortcuts
 Wizards Tab, PhotoStitch Wizard Drop-Down: 
 Keys: Alt, W, P R

Using the PhotoStitch Wizard
1 Start the Wizard. It opens at the Choose Embroidery Type page.
2 Click the desired option. Choose from:

• Create Color PhotoStitch Embroidery
• Create Sepia PhotoStitch Embroidery
• Create Monochrome PhotoStitch Embroidery
• Create Color Tile PhotoStitch Embroidery
• Create Linear PhotoStitch Embroidery.
Color PhotoStitch, Sepia PhotoStitch, Monochrome PhotoStitch and Color Tile PhotoStitch options are 
available only if you own PREMIER+™ 2 ULTRA.

3 Click Next. The Choose Picture page appears.

4 Click the desired option from:

• Load a Picture , to select an existing picture file.

• Paste Picture  to load the picture in the Clipboard Block.

• From Scanner or Camera  to obtain a picture directly from a scanner or digital camera.

• Social Media Picture to load a picture from Facebook® , Instagram® , Flickr® , or 

Twitter® .
5 Select your picture. The picture will appear in the preview pane.
6 Click Next. The Rotate and Crop Picture page appears.
7 If required, rotate the picture to any angle from 0 to 359 degrees. This can be useful when 

straightening scanned pictures.
8 If required, adjust the crop lines to select the desired area of the picture. Click Automatic to start 

again.
Click and drag anywhere inside the crop box to move it.
The dotted lines show the crop size.
Alternatively, crop to a fixed orientation, selecting from square, portrait and landscape.
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9 Click Next. The Remove Background page appears.
10 Use Flood Fill  to remove adjacent areas with a similar color. Use the Large , Medium  and 

Small  Erasers to ’wipe out’ background areas.

Use Undo  to reverse the last action, and Reset to go back to the original picture.

For a linear PhotoStitch it is unimportant if a few small specks of background remain, as the background 
stitch lines will be unaffected. When making a color PhotoStitch it is best to remove all specks of 
background as they may lead to ’stray stitches’.

11 Click Next. The Picture Options page appears.
12 Autolevel is initially enabled. It adjusts brightness and contrast automatically. Deselect it if the colors 

appear distorted.
13 To remove the red eye effect caused by flash photography, select Red Eye Removal  and draw an 

ellipse around the affected area. 
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14 Increase saturation to make colors more intense, for example to make pale skin tones appear 
’warmer’.

Save the picture if desired, in order to adjust the project later.
15 Click Next. The Design Size page appears. Set the size for the embroidery, using Height or Width. The 

picture proportions are kept as you resize.
16 Click Next. If Linear PhotoStitch Embroidery was selected in the Choose Embroidery Type page, the 

Choose Thread Colors page for Linear PhotoStitch will appear.
17 To change the thread color, click Thread Color , then select a new color in the Color Selection 

dialog box.
18 Select an artistic effect from the drop-down list. The available options are Linear, Spiral and four Maze 

effects.

19 Use the Shade Range slider to adjust the range of light and dark in the picture.
This page also displays the number of stitches in the embroidery, its height, width, and the total number of 
color changes.

20 Select Enhance Detail to bring out detail in the picture, for example in a photo where the face is clear, 
but the contrast is poor.
Scan Depth refers to the distance between the lines that produce an embroidery from a picture. The lower 
the Scan Depth figure, the finer the detail in the embroidery, and the more stitches produced.
Density changes the density of the stitching along each line, where 1 is the standard default density and 40 
is the most open, with the fewest stitches.

21 Click Finish to close the wizard.
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Creating a Color PhotoStitch
If you own PREMIER+™ 2 ULTRA, the extra options Color PhotoStitch, Sepia PhotoStitch, Monochrome 
PhotoStitch and Color Tile PhotoStitch will be available in the Choose Embroidery Type page.

22 In the Choose Embroidery Type page, select an option and click Next.
23 Progress through the following pages, setting options as desired and clicking Next. The Choose 

Thread Colors page appears.
24 Adjust the number of colors with the arrows in the Color Selection box, or type in the required 

number of colors.
If desired, Focal Area can be used to concentrate on the flesh tones in a face, rather than the color of the 
hair or clothes.

25 To change a particular thread color, select the color, click Change Thread, then select a new color in 
the Color Selection dialog box.
Remove the selected color from the list with Delete, or all colors in the list with Delete All. Go back to the 
original color list with Reset.

26 Click Next. The PhotoStitch Embroidery Options page appears.
27 Select Enhance Detail to bring out detail in the picture, for example in a photo where the face is clear, 

but the contrast is poor.

Enhance Detail does not change the colors used, it affects the way that those colors are used.
This page also displays the number of stitches in the embroidery, its height, width, and the total number of 
color changes.

28 Click Finish to close the wizard.
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Choose Embroidery Type

The Color PhotoStitch, Sepia PhotoStitch, Monochrome PhotoStitch and Color Tile PhotoStitch options are 
available only if you own PREMIER+™ 2 ULTRA.

Choose Picture

Use the Choose Picture page to select the picture you wish to convert to a PhotoStitch. 
The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Photos for Linear PhotoStitch
Pictures for Linear PhotoStitch work best when they have strong contrast on the facial 
features, and no areas of shadow on the face.

Photos with face to camera tend to work better than those taken from the side, as the other side of the face 
is in shadow. A pale background is often better than a dark background. Try removing the background in 
PREMIER+™ 2 PhotoStitch, if owned, or picture editing software. Save the picture before making the 
PhotoStitch.

Create a full color embroidery

Use monochrome or sepia
Use a color tile effect
Use a single thread to create a
single color embroidery

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®
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Rotate and Crop Picture

If required, rotate the picture to any angle from 0 to 359 degrees. This can be useful when 
straightening scanned pictures. Use the Crop lines to select the section of the picture that 
is to be used to create the PhotoStitch. 

To obtain more detail on an individual’s face it is often helpful to crop so that only the head and part of the 
shoulders are shown. 
Click and drag anywhere inside the crop box to move the crop box.

Remove Background

Use the Remove Background page to remove the background from the photo, so as to 
emphasize the person’s face, or other subject.

Best results may be obtained if the background is completely removed, leaving only the face itself. 
Removing heavily contrasting colors in the background brings out the subtle color variations in the 
person’s features.
For a Linear PhotoStitch it is unimportant if a few small specks of background remain, as the background 
stitch lines will be unaffected. When making a color PhotoStitch it is best to remove all specks of 
background as they may lead to ’stray stitches’.

Change the angle of the picture

Zoom in and out

Use the default crop settings

Adjust the crop lines as desired

Select all of the picture

Crop the picture to a set shape

Zoom in and out

Remove areas of a similar shade

Remove background areas
with one of the erasers

Undo the last action
Start again
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Picture Options

Use the Picture Options page to remove Red Eye from your picture, and to adjust 
saturation and contrast in the picture.

Remove Red Eye Effect from a Picture
1 Click Select Eye .
2 Use Zoom In  to magnify the affected area.
3 Draw an ellipse around the affected eye in the Source Picture panel. Any bright red in that part of the 

picture has a blue cast added to it, to counteract the red effect.
If you make a mistake, use Reset to reverse red eye removal, then try again.

4 Check the result in the Preview panel.
5 Remove any other examples of red eye in the picture.

Design Size

Use the Design Size page to set the height or width of your embroidery, with the other 
dimension calculated from the picture.

Zoom in on the picture

Remove red eye effect

Return to the original picture

Adjust grays and flesh tones

Improve brightness & contrast

Save the edited picture

Set the height or width
of the embroidery
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Choose Thread Colors

Use the Choose Thread Colors page to match thread colors to colors in the picture. The 
Choose Thread Colors page of the PhotoStitch Wizard only appears when you are creating 
a color, sepia, monochrome or color tile PhotoStitch.

Choose Thread Colors (Linear PhotoStitch)

The Linear PhotoStitch version of the Choose Thread Colors page of the PhotoStitch 
Wizard only appears when you are creating a linear embroidery.

Use the Choose Thread Colors page to choose the color for the embroidery. Optionally, 
select an artistic stitch effect, choose whether or not to change the angle of the stitching, 
and enhance detail and contrast in the picture.

Artistic Effect
Select an artistic effect from the drop-down list. The available options are Linear, Spiral 
and four Maze effects.

Select a Thread Range

Delete all colors

Change a thread color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list
Set the number of colors

Change the embroidery color

Use a spiral or maze effect
Alter the stitch line angle

Bring out detail in the picture
Adjust distance between lines
Change the stitch density

Change the contrast

Place on the work area
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Monochrome Linear
Use Monochrome Linear  to use straight lines of thread for the basic stitch pattern. The 
lines are smooth for light areas of the picture. Zigzag stitches on either side of the lines 
emphasize the detail of the picture. 

Monochrome Spiral
Use Monochrome Spiral  to use circular lines of thread for the basic stitch pattern. The 
lines are smooth for light areas of the picture. Zigzag stitches on either side of the lines 
emphasize the detail of the picture.

Monochrome Maze
Use the Monochrome Maze ( , ,  and ) modes to use one of four patterns to 
build up the picture. The stitching is sparse for light areas of the picture, which also reveals 
the basic shape used by the Maze mode you have chosen. Increased density of stitching 
emphasizes the detail of the picture.

Angle
Use Angle to change the angle at which the stitches are created for the embroidery.

Enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number. The 
computer will recalculate how to stitch the picture.
Changes in Angle are visible in the preview pane.

Shade Range
Change the contrast in the picture. Negative values make the picture darker, and positive 
values make the picture lighter.

Enhance Detail
Enhance Detail makes details in the picture more prominent. For example, it can be used 
to improve definition in a photo with good detail, but little contrast.

Scan Depth
Scan Depth refers to the distance between the lines that produce an embroidery from a 
picture. The lower the Scan Depth figure, the finer the detail shown in the embroidery, and 
the more stitches produced. Scan Depth may be altered from 1 to 20 (recommended 
setting 2). The default setting is 2.

Changes in Scan Depth are visible in the preview pane.

Density
Density of stitching along each line may be set from 1 to 40. The lower the number, the 
closer together the stitches and the more stitches are produced.

Depending on the fabric and machine used, a lower number may produce more detail in 
the embroidery. However, the recommended (and default) setting is 2.

Changes in Density are visible in the preview pane.
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PhotoStitch Embroidery Options

The PhotoStitch Embroidery Options page allows you to view and check the final design 
in 3D before closing the PhotoStitch Wizard. 

After creating a PhotoStitch embroidery, use the Frame or Border tabs to complete your 
project. Add lettering too, if you wish.

Color Tile Options

The Color Tile Options page of the PhotoStitch Wizard only appears when you are creating 
a color tile embroidery. Use the Color Tile Options page to select tiles, and set the stitch 
options for them.

PREMIER+™ 2 PhotoStitch
In the PREMIER+™ 2 PhotoStitch module you can edit your picture further. Remove 
background areas and red-eye and use image effects and painting tools to improve your 
pictures. Frame the PhotoStitch automatically with your choice of hundreds of frames, 
corners or even machine motif stitches. For more information, see the PREMIER+™ 2 
PhotoStitch Reference Guide and Help. Only available if you own PREMIER+™ 2 ULTRA.

View the design information

Preview the embroidery

Make further edits
Place on the work area

Enhance detail in the picture
Change the stitch density

Zoom in and out

Select Satin or Fill tiles

Set the stitch angle

Choose a tile shape & size

View the design information
Place on the work area
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7Quilt Block Wizard
Use the Quilt Block Wizard  to create a filled or outline quilt block automatically – you 
can even create a quilting fill around an embroidery!

The Quilt Block Wizard is only available in PREMIER+™ 2 Embroidery Extra.

The most recently used quilt block dimensions are remembered, even if the program has been restarted. 
Information about the Fill Pattern used is stored in the settings of the embroidery that is created.

Select Quilt Block Style
The Quilt Block Wizard starts at the Select Quilt Block Style page. This enables you to select 
one of five quilt block styles.

Select a style for the quilt block. Choose the desired option, and then click Next to go to 
the Select Size page.

Fill surrounding an embroidery
Filled internal shape
Shape surrounded by fill
Filled quilt block
Quilt block; no shape or fill
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Filled Quilt Block; Inner Embroidery
Use Filled Quilt Block; Inner Embroidery to make a filled quilt block 
surrounding an embroidery.

Outline Quilt Block; Filled Inner Shape
Use Outline Quilt Block; Filled Inner Shape to make an unfilled quilt block 
containing a filled shape.

Filled Quilt Block; Outline Inner Shape
Use Filled Quilt Block; Outline Inner Shape to make a quilt block with an 
unfilled shape, surrounded by a fill.

Filled Quilt Block; No Inner Shape
Use Filled Quilt Block; No Inner Shape to fill the quilt block with a motif or 
pattern.

Outline Quilt Block; No Inner Shape
Use Outline Quilt Block; No Inner Shape to create a quilt block without any 
internal shape or fill. This option is useful when creating blocks to piece.

Select Size
Use the Select Size page to select a shape for your quilt block, set its size and angle, and 
add a cut line around the block.

Select one of nine shapes from the drop-down list.

All of these quilt block shapes can be tessellated — they will fill an area if tiled individually or combined 
with another shape, with no overlaps or gaps.
Use Angle to change the angle at which the quilt block is created and displayed. This is an 
easy way to place a block "on point".

Click the Rotate 45 icon  to rotate the shape by 45 degrees in a clockwise direction.

Select one of nine shapes

Set the quilt block angle

Set the quilt block size

Create a seam allowance
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Load Embroidery

The Load Embroidery page enables you to load an embroidery to use in the center of your 
quilt block. 

Adjust Embroidery
If you loaded an embroidery that was too large for the specified quilt block, it will be outlined in red. Return 
to the Select Quilt Block Style page and choose a different size for the quilt block, or select another 
embroidery.

Use the Adjust Embroidery page to set the angle and position of the embroidery within 
the quilt block, and the margin around it.

Browse for an embroidery

Paste a copied embroidery

View the clipboard contents

Preview the opened embroidery

Drag the embroidery into place

Set the embroidery angle

Flip the embroidery horizontally
Flip the embroidery vertically

Set the space around the
embroidery
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Select Shape

Select an internal shape for your quilt block, and set its size and angle.

Select Fill Pattern

Choose a fill type for your quilt block, and set the options for it.

Select an internal shape

Set the angle of the shape

Enter dimensions for the shape

Click & drag to resize the shape

Create a stippled fill

Create a fill of parallel lines

Create a crosshatched fill area
Select decorative stitches 

Use echo lines around the 

Create a fill of contour lines

Select a shape and motif lines

for a motif fill

shape or embroidery
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Quilt Block Wizard Examples
Surround an Embroidery in a Quilt Block with an Echo Fill

1 In the Wizards tab, click Quilt Block . 
The Select Quilt Block Style page appears.

2 Select Filled Quilt Block; Inner Embroidery .
This will create a filled quilt block with an embroidery in the center.

3 Click Next. The Select Size page appears.
4 Click the drop-down arrow to the right of the Shape list. There are nine shapes to select 

from.
All of these quilt block shapes can be tessellated — they will fill an area if tiled individually 
or combined with another shape, with no overlaps or gaps.

5 In the Shape drop-down list select Shape 6, a hexagon.
6 In Enter Size, click the arow on the drop-down menu. For a hexagon you can select 

from Point to Point, Side, or Side to Side.
7 Ensure that Point to PoInt is selected in Enter Size.
8 Set measurement A to 150mm.
9 Ensure that "Include a cut line around my Quilt Block" is selected.

10 Click Next and the Load Embroidery page of the wizard will appear. 
11 Click the Open Embroidery icon  and the Open dialog box appears.
12 In the Open dialog box, browse to the folder 

Documents\Premier+2\Samples\Premier+Emb\Stitch2\Flowers.
13 If required, scroll down to see more embroideries until you see the embroidery 'Iris Single'.
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14 Click the 'Iris Single’ embroidery 
to select it, then click Open and 
the embroidery will be loaded 
onto the preview area.
The dimensions, number of 
stitches, and thread colors used in 
the embroidery are shown below 
the preview pane.

15 Click Next. The Adjust Embroidery 
page will appear. The embroidery 
is placed in the center of the quilt 
block shape, with a clear margin 
and blue fill area surrounding it.

16 Click Rotate 45  twice. The 
embroidery rotates clockwise by 
90 degrees in the preview pane.
You can use Angle and Rotate 
45  to rotate the shape by 45 degrees, or an angle that you choose, in a clockwise direction.

17 Set the Angle numbers box to zero to return the embroidery to its original position.
18 Click Mirror Vertically  to reverse the embroidery.

Use Mirror Horizontally  to mirror the embroidery from top to bottom, or Mirror Vertically  to mirror 
the embroidery from left to right.

19 Click Mirror Vertically  again to set the embroidery back to the previous position.
20 Click the up arrow next to Margin to increase the margin by 2mm. The margin around the flower 

embroidery grows larger.
21 Click and drag the embroidery so that the margin lies 

outside the edge of the quilt block. The blue fill 
disappears, and the line showing the edge of the 
margin becomes red.
You could drag it back to its original position, but it is just 
as easy to reload the embroidery.

22 Click Back. In the Load Embroidery page, click Open 
Embroidery to open the Open dialog box and load Iris 
Single again.

23 Click Next. In the Adjust Embroidery page the 
embroidery has returned to its original position and 
settings.
If you had clicked Next without loading the embroidery 
again, your changes would have been retained.
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24 Click Next. The Select Fill Pattern 
page will appear.
The embroidery is surrounded by 
an unstitched margin, and the 
default fill, a Stipple Fill. The 
Options button is available to 
change the Stipple Fill settings.

25 Click Echo . The fill around the 
embroidery changes to an Echo 
Fill.
The outer lines in the echo fill follow 
the outline of the quilt block, while 
the inner lines follow the outline of 
the embroidery.

26 Click the Options button for Echo 
Fill. The Echo Fill properties dialog 
box opens.

27 Set the Gap to 4.0mm, and ensure the Stitch length is 2mm.
The Style is set to style 1, rounded corners. You can also use square (Style 2) or diagonal (Style 3) corners.
These styles have more significant effects when using the Inner Shape quilt block options.

28 Click OK to view the effect of the changes. 
29 The gap between the embroidery and the echo lines is greater than 

the gap between the lines themselves. Click Back to return to the 
Adjust Embroidery page.

30 Set the Margin to 4mm, then click Next to return to the Select Fill 
Pattern page. 
The first line in the echo fill now starts at the same distance from the 
embroidery as the other lines are from each other.
There are several small ’islands’ around the flower .

31 Under Echo, click Options and in the Echo Fill dialog box set the Gap 
to 4.2mm. Click OK.
This increases the distance slightly between the lines of stitching, and removes the small islands, but is still 
similar to the margin.

Adjust the Gap and Style, and the position of the embroidery to achieve your preferred results.
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32 Click Finish to place the finished quilt block in the work 
area, as shown.
Two rows of stitching around the quilt block show the lines at 
the edge of the block where the fabric should be cut and 
folded.
Note the orange handles for the group created from the 
embroidery, the echo lines and the cut line.

33 In the Color Worksheet, select the colors for the echo lines 
and the cut line and change them to the dark purple used 
in the Iris petals in the embroidery. 
The color of the stitching in the fill now matches the main 
color in the embroidery.

Show an Echo Around an Embroidery
1 Click New , then in the Quick Access toolbar, click Insert Embroidery . The Open dialog box 

appears.
2 In the Open dialog box, browse to Documents\Premier+2\Samples\Premier+Emb\Stitch2\Quilting.
3 Click the Blanket Stitch Flower embroidery to select it, then click Open. The flower design appears in 

the work area.
4 With the flower embroidery still selected, in the Home tab click Copy . The flower appears in the 

Clipboard.
5 In the Wizards tab, click Quilt Block . The Select Quilt Block Style page appears.
6 Select Filled Quilt Block; Inner Embroidery .

This will create a filled quilt block with an embroidery in the center.
7 Click Next. The Select Size page appears.
8 Click the drop-down arrow to the right of the Shape list. There are nine shapes to select from.

All of these quilt block shapes can be tessellated — they will fill an area if tiled individually or combined 
with another shape, with no overlaps or gaps.

9 In the Shape drop-down list select Shape 6, a hexagon.
10 Ensure that Point to Point is selected in Enter Size, and that "Include a cut line around my Quilt Block" 

is selected.
11 Set measurement A to 200mm.
12 Click Next and the Load Embroidery page of the wizard will appear. The Blanket Stitch Flower can be 

seen in the Clipboard Block in the dialog.
13 Click Paste . The blanket stitch flower is placed in the preview pane.

Use Copy and Paste to use embroideries that you have created or loaded in PREMIER+™ 2 Embroidery in 
the Quilt Block Wizard.
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The dimensions, number of stitches, and thread colors used in the embroidery are shown below the 
preview pane.

14 Click Next. The Adjust Embroidery page will appear. The embroidery is placed in the center of the 
quilt block shape, with a clear margin and blue fill area surrounding it.

15 Click Next. The Select Fill Pattern page will appear.
The embroidery is surrounded by an unstitched margin, and the default fill, a Stipple Fill. The Options 
button is available to change the Stipple Fill settings.

16 Click Echo . The fill around the embroidery changes to an Echo Fill, emphasizing the blanket 
flower.
The outer lines in the echo fill follow the outline of the quilt block, while the inner lines follow the outline of 
the embroidery.

17 Click Finish to place the finished quilt block in the work area.
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8Word Sculpt Wizard
Use the Word Sculpt Wizard  to create a word design 
automatically using your choice of outline, words, and 
fonts.

The Word Sculpt Wizard is only available in PREMIER+™ 2 
Embroidery Extra.
The initial size is set by the hoop. The most recently used values 
are kept within a session. Information about the outline, words 
and font used is stored in the settings of the embroidery.

Select Outline
Use the Select Outline page to select a shape for your 
design, set its size and angle, choose a stitch type for the outline and adjust its settings.

Select Words

The Select Words page enables you to enter words, and place them inside the outline.

Select one of over 300 shapes

Set the design size

Set the design angle

Miror the design outline

Choose & adjust a stitch type

View the design information

Enter words for the design

Use each word once

Choose one font for the design

Set the orientation of the words

Use only capital letters

Set the font size and margin
Use a random variety of fonts

Select a color palette

Show or refresh the preview
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Create a Fish Word Sculpt Design
1 In the Wizards tab, click Word Sculpt . The Select 

Outline page  of the Word Sculpt Wizard appears.
A large hoop is best when creating a word scultpture.

2 Click the drop-down arrow for the Shape list. There are 
over 200 shapes to select from.

3 In the Shape drop-down list scroll down to the Animals - 
Underwater category, and select the shape Fish 3.
The size of the design is set by the currently selected hoop. 
There is no need to change the settings in Select Size for this 
design.

4 Ensure that Angle is set to 0, and that Mirror is not 
selected.
Use Angle and Mirror to adjust the position of the outline.

5 In Stitch Type ensure that Satin Line  is selected.
For a different effect, you can select Motif Line , and click 
Options to choose a different motif and its settings.

6 Click Next and the Select Words page of the wizard will appear. 
7 In the Words text box, enter the words or phrases to use in your design, separated by a comma.

Not all of your words may be used. Use a word twice in your list if you want it to be frequent in the design.
You may find it easier to create the list in a text editor and paste it in.
If desired, deselect Upper case only to use upper and lower case letters, and select Use words once 
only if you do not want words repeated.

8 Set Margin to 1mm to place the words close to each other.
9 Reduce Font Size to 11mm to enable more words to fit into the fish outline.
10 Ensure that Random fonts is selected.

Random fonts will use a variety of fonts reccommended for the selected Font Size. For example, both 
Antonia 10-20mm and Arial 08-14mm may be used when the Font Size is set to 11mm.

11 In Color Theme, select Blue from the drop-down menu. The outline and words now use various 
shades of blue.

12 In Orinetation ensure that Random is selected.
For a different effect, choose Horizontal and vertical or one of the other options.

13 Click Refresh Preview to use your updated settings.
14 Click Refresh Preview again. The arrangement of the words and the number of words used changes.
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15 Change the settings and use Refresh Preview until you are happy with the results.

16 Click Finish to place the design in the work area. Save  this original version, if desired.
The design is loaded as a Group, and each word is a lettering Block with Curve line types at Top and 
Bottom, and Constraint set to Free. You can mould each Block to almost any shape you wish.

17 Click Restrict Groups , then click the yellow handle on one of the letttering Blocks. You can see the 
settings for the Block.

For more information on adjusting lettering Blocks, see Creating Lettering in the PREMIER+™ 2 Embroidery 
Reference Guide or Help.

18 Click and drag the handles on the bock to mould it to the desired shape.

Use Previous Design  and Next Design  to move between the designs in the Group.
19 To change the font in a lettering Block, 

right-click the Block and select Properties in 
the Context menu.
If you want to mould a lettering Block to a 
larger size, a different font may look better. 
Check the size range before changing.

20 To add a word to the design, Copy  then 
Paste  one of the words, and move it to 
the desired position. 

21 Right-click the new word, and in the Letter 
Properties dialog box change the text and 
font. Click OK.

22 In the Color Select area on the Design Panel, click the thread color and set it to match the theme. 
23 Mould tne new word to shape.
24 Add words to your design and mould them to shape, then Save  your finished design.
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9Project-in-the-Hoop Wizard
Use the Project-in-the-Hoop Wizard  to create an in-the-hoop design using your 
choice of project type, style and dimensions. Follow the PDF instructions to stitch out your 
project.

The Project-in-the-Hoop Wizard is only available in PREMIER+™ 2 Embroidery Extra.

Using the Project-in-the-Hoop Wizard
Select a design Category and a Style, then enter the Dimensions of your project. Click the 
View PDF Instructions button to view and print a copy of the PDF stitchout instructions.

After you click OK to select the project, read the instructions in 
the PDF, view how the project is constructed in the Design 
Player , and then make any customizations to the main 
design in the work area.

Ensure that you change only the decorative embroidery, and not the 
construction stitching. Preserve the order of the sections of the project.

Use the Previous Design  and Next Design  buttons on the Home 
tab to step between the sections of the project.
Change the color of the construction stitching, and the 
decoration, to suit your fabric.

Save  your project, and then stitch it out in a suitable hoop, 
following the instructions.

Select a project Category

Preview the project type

Select a project Style

Preview the project design

Set the Dimensions for your project

Click to view and print the PDF stitchout instructions
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10Family Tree Wizard
Use the Family Tree Wizard  to create an embroidered family chart of up to three 
generations of ancestors or descendents for an individual.

The Family Tree Wizard is only available in PREMIER+™ 2 ULTRA.
Enter the names and 
relationships of other 
family members, and 
select lettering, a frame 
and connectors to use for 
the family chart.

Send the tree with the 
chosen theme to adjust in 
PREMIER+™ 2 Family Tree. 
It is also saved as a .ged 
file. On the work area use 
Save or Save As to save 
the family tree embroidery as a grouped .vp4 file for later use.

The most recently created family tree is stored by the wizard. It is reopened the next time the wizard is used.
For more information on the Family Tree Wizard, see the PREMIER+™ 2 Embroidery 
Reference Guide, and for information on PREMIER+™ 2 Family Tree, see the PREMIER+™ 2 
Family Tree Reference Guide.

Family Tree Wizard
Select the Family Tree Wizard  in the Wizards tab to create a family tree for an individual. 
The Family page of the Family Tree Wizard will appear.

Enter the family members for a Descendants Chart or for an Ancestors Chart, and choose 
how the names will be presented. Select a font style, thread color, shape and size. 
Surround the names with a frame or flourish. Choose Connectors to link the partners in 
the chart.

Progress through the pages using Next  and Back  to alter each setting, or click 
Finish  at any time. Click Cancel  to close the wizard without creating a family tree.

Any existing family tree will be retained in the work area.

Shortcuts

 Wizards Tab:  
 Keys: Alt, W, F

Overview
1 In the Wizards tab, click Family Tree  to start the Family Tree Wizard.
2 In the Family page, choose whether to start a Descendants Chart , or an Ancestors Chart .
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A Descendants Chart shows the partner, children, grandchildren and great-grandchildren of the selected 
individual. This example uses a Descendants Chart.
An Ancestors Chart shows the father and mother, grandparents, and great-grandparents of the selected 
individual.

3 If you have previously created a family tree chart, you will be asked if you want to remove the family 
data that you previously entered. Click Yes to continue. The First Individual dialog box opens.

To save an existing family tree as a .ged file, in the Family page click Send to PREMIER+™ 2 Family Tree .
4 In the First Individual dialog box, enter the Given Name and Family Name of the person the tree is for, 

and indicate if they are Male or Female.
5 Click Next to enter further individuals in the family tree.

The family chart embroidery appears as you enter the data.
6 Enter the names and gender of the partner and children of the first individual, adding the oldest first.
7 Click Next to add grandchildren (the children of the oldest child).

Click Next again to add grandchildren for each of the other children, and then to add great-grandchildren 
for each of the grandchildren.

8 When you have finished entering information for the family tree, click Close to view the tree in the 
Family page of the wizard.

Use the First Individual , Children , Grandchildren , and Great-Grandchildren  buttons to change 
the details for the individuals that you entered. The dialog box opens at the oldest; click Next to view the 
other siblings.

9 Use the Display Names As options to show only the Given Names, or to also view the Family Names.
10 Click Next  to change the lettering used in the family tree.
11 In the Lettering page select the style for the text in the family tree. Choose the font, size, color, 

spacing and stitch type options for the names.

12 Click Next  to change the frames used in the family tree.

Enter the details for the First 
Individual in the family tree.

Add the details for the children of 
the First Individual.

Add the details for grand-children 
of the First Individual.

Choose a font

Set the font size and layout

Set the connection type

Set the stitch type options Change the thread color

Adjust other settings or finish
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13 In the Frame page choose whether to use frames, and select a frame, corners, side pieces or a flourish 
for each individual. Change the color and stitch options for the frame.

14 Click Next  to change the connectors used between partners in the family tree.
15 In the Connectors page select satin line or a running stitch line for connectors, or use no connectors. 

16 Choose a single or double line connector for partners. Change the thread color used for connectors.

17 Check your work by clicking the wizard tabs or by using Next  and Back  to view the Family Tree 
Wizard pages. Adjust your settings as desired.

18 Click Finish  to place the family tree chart in the work area as a grouped .vp4 file with fixed lettering 
and frames.

PREMIER+™ 2 Family Tree
In the PREMIER+™ 2 Family Tree module you can create an embroidered chart of your 
family tree with PhotoStitch embroideries, or with appliqué pictures of your family.

Place a frame around each name

Use a Frame, Corners or Side Pieces

Use flourishes Select a frame
Choose the flourish position

Change the thread color for the frame

Change the appearance of the stitching in the frame

Adjust other settings or finish

Adjust other settings or finishChange the thread colorChoose a line type for the connectors

Use double stitch lines to indicate a partnershipChange the settings for the connectors
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11Split Project Wizard
Use the Split Project Wizard  to split a large embroidery project into sections for 
stitching out.

The Split Project Wizard is only available in PREMIER+™ 2 Embroidery Extra.

Using the Split Project Wizard
1 With a large project open, 

click Split Project  on the 
Wizards Tab. The Split 
Embroidery page opens.

2 Click Change Hoop to select 
your desired hoop (here, 
240mmx150mm - Universal 
Large Hoop 2).

3 Select a Hoop Group, a Hoop 
Size, and the Orientation.
To minimize the number of 
hoopings when stitching out, 
select the largest single-part 
hoop for your embroidery 
machine.

4 In many circumstances, the 
initial setting for the other 
options on this page will work best, so make an initial split using these settings. If important features 
in the embroidery are split, click Back and adjust your settings.

5 Adjust your settings on the Split Embroidery page, testing the results, until you are satisfied with the 
split lines. Use the preview when adjusting the hoop and Overlap.
Increase or decrease Overlap to fit your embroideries within the hoop.
For Connection, use Running Stitch, not Trim if you have to split large stitch areas.
Use Corner alignment stitches if lightly embroidered areas are split, and Baste if heavily embroidered areas 
are split. Some machines have special positioning features which do not require alignment stitches.

6 Click Next. The Save 
Embroidery page appears.

7 Use the View Previous  and 
Next  buttons to preview 
the splitting of the 
embroidery and, if necessary, 
go back to the Split 
Embroidery page to adjust 
your settings.

8 Click Export All Sections  
to save the split embroidery. 
Browse to your My Designs 
folder, and name the project. 
The split sections will be 
numbered automatically.

9 Click Next. The Print Options 
page appears.
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10 Print a plan and worksheets 
for your project:
• Overview prints a plan of the 
split sections, with section 
names.
• Complete 2D Template 
prints a full size 2D template 
of the split embroidery 
sections, with an outline 
around each section to 
indicate how to join them 
together.
• Worksheets prints a 
worksheet for each section. 
The worksheet gives the 
dimensions of the design, the 
total number of stitches, a full 
list of the threads used, and the number of stitches for each thread.
The Overview and Complete 2D Template may only be printed from the Split Project Wizard.

11 Click Finish to close the wizard. 

Split Embroidery

The Split Embroidery page is displayed when the Split Project Wizard opens. Use the Split 
Embroidery page to select the desired hoop size, the splitting method, the overlap 
between hoop areas, what type of alignment stitch to use, the level of compensation, and 
the type of connection for your project.

Experiment with the embroidery splitting options. This will give you the best possible split.
To define split lines with complete control, use PREMIER+™ 2 Design Aligner, if owned.

Select a hoop for stitching out

Set the overlap 

How to split stitch areas
Set the type of alignment 

Reduce pull on the fabric 

Travel method between 
(straight line split only)

stitch areas

stitch

between sections
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Save Embroidery

Use the Save Embroidery page to preview the split sections, and to export the split 
embroidery sections automatically. 

When you save a split embroidery, you provide a single name which is used for all parts of 
the split embroidery. The split parts are distinguished by a two digit suffix that is 
automatically added to the file name. The numbers start at 01 for the top left hoop, then 
increase across and down, for example Three Flowers Exported_01 to Three Flowers 
Exported_03. The numbers are used only to distinguish the individual sections. You can 
stitch out the sections in any order, as required.

Print Options

Use the Print Options page to print information on stitching and aligning your project.

Information for this 

Zoom in and out

Browse the split sections

Export the embroidery 

split section

sections

Print a plan of the split 

Print a worksheet for each

Information used in worksheet

Full-size template for each 
section

section

sections
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Stitch Out and Align Split Project Sections
Deciding the Stitchout Order
Generally, the split sections should be stitched out from the center. However, if the 
embroidery project only uses a few hoop areas, stitch out the section with the heaviest 
stitching first, as this will be the section which pulls the fabric the most.

As with all projects, it is best to try some test stitchouts before stitching the final version. It 
is particularly important to make test stitchouts of some adjacent sections if you think 
they may be difficult to align. For example, if the split line across a fully stitched area is very 
irregular, or when one of the sections has very heavy stitching.

General Alignment Considerations
Some designs will require less precise alignment than others. If you have split an 
embroidery so that the split lines go between all the stitch areas, (for example, if no 
connectors were used), it is unlikely that you will need to have perfect alignment between 
sections. The main consideration would be to ensure the fabric is straight each time it is 
re-hooped.

However, when any stitch areas are split, alignment is crucial to achieving a good 
stitchout. Using alignment stitches and compensation of Low or High will help to align 
sections and eliminate gaps between them.

The alignment stitches are created in a color that matches the background color chosen in PREMIER+™ 2 
Configure.
There are also various alignment aids including:

 The printed full size 2D template
 Worksheets for each section, optionally printed on transparency paper
 The hoop template supplied with the hoop for your machine
 Light sensitive pens that can be used to mark fabric, and other temporary fabric marks
 Fabric stiffening aids and stabilizers that combat pull and make alignment easier
 The needle and embroidery positioning controls on your embroidery machine

Using the 2D Template
This is the most useful alignment aid. The 2D template shows the whole embroidery at the 
size it will be stitched out. Each hoop area is marked by corners and a large + in the center.

The hoop area corners show the extreme points of the stitchable area within the hoop. If 
you have a hoop template supplied with your hoop, this corresponds to the stitchable 
area shown on the hoop template, usually marked as a grid.

The template starts in the top left corner and works across and down to the bottom right 
corner. When cutting out and joining the pages together, you may find it easier to leave 
the first page uncut, then cut the dashed edge of the next page before aligning it to the 
first page and taping it in place. Continue like this until all the pages are joined together.

You can also use the template as a guide to the size of your piece of fabric. The template shows the overall 
stitchable area that will be hooped, but you will need to allow extra fabric around the edges for physically 
hooping up the fabric.
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Use the template to mark hoop centers on the fabric. Use a pin to punch a hole through 
the template at each hoop center. Pin the template to the fabric and mark the fabric 
through each hole. If the point that is marked will be stitched over and hidden, use a 
pencil or a pen to mark the center point. If the point will be on open fabric, use a light-
reactive fading pen.

Using Other Alignment Aids

Fabric Choice, Stiffeners and Stabilizers
In general, stiffer fabrics will resist pull and distortion better.

Fabric stiffening aids and stabilizers will combat pull and make alignment easier. In 
particular, iron-on backing helps to resist fabric distortion. You may wish to apply this to 
the fabric before marking the hoop centers or making any other alignment marks.

Hoop Templates and Printed Worksheets
When hooping up each section, align the center marked on the fabric against the hoop 
template to guide the position of the fabric in the hoop. If you do not have a hoop 
template, use the printed worksheet at 100% scale for the section. You could also print the 
worksheet on transparency paper.

Center Lines
You may also wish to mark lines between the hoop center points so you can line up the 
fabric to the center marks on the frame of the hoop. This is especially helpful if you do not 
have a hoop template. Use a light-reactive fading pen to mark temporary lines just before 
you hoop the fabric. An alternative is to iron creases into the fabric as lines between the 
center points.

Stitching Out the First Section
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.

If you are unable to do this on the machine, this means that you have not hooped up your fabric with 
sufficient accuracy. You will need to move the fabric in the hoop and try again.
If you did not generate alignment stitches, simply start stitching out.

If you have alignment stitches in your split embroidery sections, each section starts with a 
sequence of movement stitches. These movement stitches jump to the corner of a 
rectangle within the stitchable area of the hoop, that is half way across the overlap 
between the hoop areas. For the first section, skip past these movement stitches and then 
start stitching out.

Aligning a Section to Previous Sections
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.
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Aligning With No Alignment Stitches
Use the 2D template or full size worksheet to confirm that the embroidery will connect 
correctly to previous sections. This is easier to do if you have printed the template or 
worksheet on transparency paper. If you created test stitchouts, this will help you judge 
the positioning according to the effect of the fabric properties.

Aligning With Corner or Baste Alignment Stitches
The previous sections will have placed alignment stitches that mark the corner positions, 
either as a small set of corner stitches or lines of basting stitch that meet at the corner. Use 
the machine controls to step through the sequence of movement stitches that should 
match up to the corners.

Adjust the machine so that the needle is over the appropriate corner for each movement 
stitch position. If there are no split stitch areas around the edges of the section that need 
joining to previous sections, your alignment should now be accurate enough to start 
stitching.

As the number of sections that must be stitched out increases, the type of fabric and embroidery become 
even more relevant for obtaining a good stitchout. Accurately hooped fabric and the alignment aids will 
help, but test stitchouts are also important.
If the section must join to stitch areas in previous sections, use the 2D template or full size 
worksheet to confirm that the embroidery will connect correctly. This is easier to do if you 
have printed the template or worksheet on transparency paper. If the alignment is too far 
out, it may be necessary to hoop up your fabric again.

Before starting to stitch, check the alignment stitches of the previous sections, and trim 
any that may be overlapped by the section you are about to stitch out. New alignment 
stitches will be added at the end of this section, to replace any that you trim.

PREMIER+™ 2 Design Aligner
In the PREMIER+™ 2 Design Aligner module you can split large embroideries automatically 
for use in any hoop. Choose one of your standard hoops for splitting any size design and 
automatically calculate the number of hoops needed. Then adjust the split lines exactly as 
you wish. Alternatively, split a design for a specific multipart hoop. The intelligent cutting 
routine minimizes movement stitches and color changes in the split embroidery sections.

For more information see the PREMIER+™ 2 Design Aligner Reference Guide and Help.

PREMIER+™ 2 Design Aligner is available only if you own PREMIER+™ 2 ULTRA.
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12Modifying Embroideries
Use the Modify tab to edit and insert stitches, or select a block of stitches for editing. Hide 
stitches by color or by using the draw range. Cut and copy blocks of stitches or whole 
embroideries and paste them. Insert new color changes, change the order of colors and 
merge color blocks. Adjust a selected block of stitches precisely, changing its angle and 
size.

The Modify tab is only available in PREMIER+™ 2 Embroidery Extra. All Quick Access toolbar functions 
except Change Hoop, Undo and Redo are unavailable in the Modify tab.
If more than one design or a group is selected when you click the Modify tab a warning 
message will appear. To edit a single design in a multiple selection, click the work area to 
deselect, then select the desired design. If a group is selected, use Restrict Groups on the 
Home tab or the context menu, then select the desired design. If lettering, a SuperDesign 
or Frame is selected, a warning message will appear that it will be fixed as embroidery 
stitches. Only use the Modify tab in this case if you are prepared to lose the ability to adjust 
the properties such as font and stitch type. Decoration designs cannot be altered on the 
Modify tab.

Viewing Embroideries in the Modify Tab
Embroideries are shown in the Modify tab in 2D View as 
individual stitches with no shading. The selected 
embroidery is shown in color. Any other embroideries use 
pale ghost stitches.

Automatic Ghost Mode
When the Modify tab is selected to edit an embroidery, only 
the embroidery selected for editing is shown in color. All 
other embroideries are automatically shown as pale ghost 
stitches. This allows you to see the positions of other 
embroideries, so that you can observe where they are in 
relation to the embroidery you are editing.

Select a block of stitches

Switch between resize & rescale

Show the selected stitches

Measure a distance

Insert color changes, Stops & stitchesCut, copy or paste a block

Resize or rotate a block
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Get Length
Use Get Length  on the View tab (and on the Modify tab if 
PREMIER+™ 2 Embroidery Extra is owned) to measure the distance 
between any two points on an embroidery. Click the Get Length 
icon  and the mouse pointer changes to the Measure pointer . 
Then click and drag a line across the embroidery. The length of the 
line is displayed.

For example, use this to obtain the width of a column of stitches or 
the distance between lines of stitching.

The length is shown in millimeters or inches, according to the setting for Show 
Measurements in PREMIER+™ 2 Configure. The alternative units are shown in 
parentheses.

Measure Part of an Embroidery
1 Click the Get Length  icon. The pointer changes to the measure pointer .
2 Click and drag across the part of an embroidery you want to measure.
3 Read, and if desired, make a note of the number.
4 Repeat the click and drag to measure any other distances, as required.
5 Right-click to deselect the function.

Cut, Copy, Paste and Duplicate
The Cut, Copy, Paste and Duplicate functions are available for whole embroidery(ies) and groups on the 
Home tab of PREMIER+™ 2 Embroidery.
The Modify tab to work with blocks of stitches is only available in PREMIER+™ 2 Embroidery Extra.

Clipboard Block
The Clipboard Block shows the current block that can be pasted 
into your embroideries. It shows the most recent block of stitches, 
embroidery(ies) or group that has been cut or copied from 
PREMIER+™ 2 Embroidery or another PREMIER+™ 2 Embroidery 
System module. It can be used as many times as desired, until a new 
block is cut or copied.

Click in the clipboard to remove the current Clipboard Block.

Cut
Use Cut  to remove a whole embroidery or the currently selected block of stitches from 
the embroidery and make it the Clipboard Block.

Copy
Use Copy  to make a copy of a whole embroidery or the currently selected block of 
stitches. The copy becomes the Clipboard Block, where it can be pasted as many times as 
required, or pasted into another PREMIER+™ 2 Embroidery System module.
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Paste
Use Paste  to paste the Clipboard Block as a separate embroidery or, if the Modify tab is 
selected, attach it to the last currently visible stitch of an embroidery. The Clipboard Block 
shows the current stitches that will be pasted. If a group, lettering, a SuperDesign or Frame 
has been copied, a warning message will appear that it will be fixed as stitches if you paste 
into the Modify tab. Only use the Modify tab in this case if you are prepared to lose the 
ability to adjust the properties such as font and stitch type. 

If you paste a design with decorations into the Modify tab, the decorations are not visible. They will 
reappear as separate subdesigns when you move to one of the other tabs.

Paste into Center
Use Paste into Center to paste the Clipboard Block in the center of the hoop. The 
Clipboard Block shows the current stitches that will be pasted.

Duplicate
Use Duplicate  to make a copy of the selected embroidery or block of stitches, which is 
automatically pasted on the work area below and to the right of the original.

The copied stitches are shown in the Clipboard Block on the control panel.

Delete
Use Delete  to delete one or more selected embroideries, groups or blocks of stitches 
after they have been selected using one of the block selection methods (Box Select , 
Freehand Select , Freehand Point Select  or Select All Visible ) on the Modify tab.

When all visible stitches are deleted because no block is selected, all remaining stitches 
are shown.

Delete Single Stitches
When you have a single stitch selected, Delete  will remove the stitch.

Select and Edit Single Stitches
Select Stitches
Use Select Stitches  to select and 
edit single stitches. Simply click a 
stitch and a box appears around it to 
show that it is selected.

It may be helpful to zoom in close enough to 
see the separate stitches.
Click and drag the box to move the 
stitch. If desired, use Delete  to 
delete the stitch point.
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Select a Series of Stitches
Click the first required stitch point, then hold down Shift (on the keyboard) and click the 
last required stitch point. The two stitches you click and all stitches between them will be 
selected. Click outside the block to make a new selection using this method.

To select several individual stitches, hold down Ctrl and click the desired stitches.

Alternatively, hold down Shift and use the left and right arrow keys to select a series of stitches.

Insert Stitches
Use Insert Stitches  to add new stitches to an embroidery. Click Insert Stitches and the 
pointer changes to the insert stitches pointer . Then click where you want to add 
stitches. The stitches will be added using the thread color where you insert the stitches. 
Click Delete to delete the last point placed. Right-click twice to deselect. If you need to use 
a different color for the stitches, insert color changes before and after the new stitches.

Use Insert Stitches for many reasons. For example, you may add more underlay to an 
embroidery or make a new section of an embroidery. You can even change an embroidery 
into an appliqué embroidery by adding placement stitches and Stops to secure the 
appliqué fabric.

Select a Block of Stitches
The block Select functions on the Modify tab allow you to select part of an embroidery. A 
selected part of an embroidery is called a block. A block can be resized, rotated, mirrored, 
moved, nudged, duplicated, copied, cut and deleted. You may find it easier to select a 
block when you have selected colors to display and/or changed the ranges of stitches that 
are visible.

When a block has been selected, it has a selection box around it on the work area. The 
selection box has handles which are used to resize, rotate and flip the block. Also, the 
block is outlined within the selection box, to assist with accurate positioning when it is 
moved or rotated.

Click and drag inside the block to move it. Use the arrow keys on the keyboard to nudge 
the block. Click and drag the square corner handles to scale the block with constant stitch 
count (white handles) or resize with constant density (blue handles), depending on Resize 
mode . Click and drag the round rotate handle to rotate the block freely. Click and drag 

Blue handles for resize White handles for scale
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the center of rotation  to rotate around a different point. Click the triangular handles to 
flip the block horizontally or vertically.

A block can also be resized/scaled and rotated precisely using the Modify Block section of the Modify tab.

Pasting a Block
When a block is pasted into an embroidery it is automatically selected as the current block 
and Box Select  is activated. The block is attached to the last visible stitch.

See “Paste” on page 68 and “Paste into Center” on page 68.

Deselecting a Block
Click the work area outside a block to deselect it. The selection box around the block will 
disappear. Right-click to turn off the current select function without deselecting the block.

Selecting an Embroidery to Modify
If there is more than one embroidery selected so that you are unable to enter the Modify 
tab, press the Tab key on the keyboard to select the embroidery you wish to edit.

Box Select
Use Box Select  to select stitches in a rectangular 
area. Click Box Select and the pointer changes to the 
box select pointer . Click and drag around the 
area you want to select. When you release the 
mouse button, the block will show you the extent of 
your selection. Right-click to deselect.

Use Box Select to make a quick selection of an area. When 
deleting a selection, if desired, use Freehand Select or 
Freehand Point Select to remove any extra stitches.

Use Add to Selection  with any select function to increase 
the area of selected stitches, or use Remove From 

Selection  to make the currently selected area smaller.

Freehand Select
Use Freehand Select  to select a block of stitches within 
an area of any shape. Click Freehand Select and the 
pointer changes to the freehand select pointer . Click 
and drag to draw an irregular outline around the desired 
area. When you release the mouse the area is closed 
automatically with a straight line between the last mouse 
position and the start position. The block will show you 
the extent of your selection. Right-click to deselect.

Use Add to Selection  with any select function to increase the area 

of selected stitches, or use Remove From Selection  to make the 
currently selected area smaller.
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Freehand Point Select
Use Freehand Point Select  to select a block of stitches 
within an area of any shape made of straight and curved 
lines. Click Freehand Point Select and the pointer changes 
to the Freehand point select pointer . Click a series of 
points to create an irregular outline of straight and curved 
lines around the desired area, using Ctrl+click to place a 
square (straight line) point. Click and drag  to 
reposition an existing point. Click Delete to remove the 
last–placed point. Right-click when the area is complete. 
The block will show you the extent of your selection. 
Freehand Point Select may be easier to use than Freehand 
Select for precise selections. Right-click to deselect.

Use Add to Selection  with any select function to increase the area of selected stitches, or use Remove 

From Selection  to make the currently selected area smaller.

Select All Visible
Select All Visible  is a one-click function that selects all visible stitches in the current 
embroidery. Click outside the block to deselect.

Select None
Use Select None  to deselect all of the embroideries and blocks in the work area, 
including any outside the hoop.

Replace Selection
Use Replace Selection  to replace the currently selected stitches with the new selection.

Add To Selection
Use Add to Selection  to add the new selection to the currently selected stitches.

Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
stitches.

Modify Block
To rotate or resize the selected embroidery or block of stitches by an exact amount, use 
the Modify Block section of the Modify tab. 

To rotate the block or embroidery, enter an angle from 0 to 359 
degrees in the Angle  box, then click Apply . If desired, move 
the center of rotation  before rotating.
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To resize the block or embroidery, change the height  and width  percentage of the 
selected block. The height and width are scaled or resized according to the Resize mode.

The size in millimeters to which the design will be changed is shown to the right.

View Selected Colors
On the Modify tab you can hide blocks of stitches according to their color. Displaying the 
stitches according to their color is an easy method of showing sections of an embroidery. 
The functions for viewing stitches by color are on the Design Panel when the Modify tab is 
open.

Hide stitches according to color, leaving the visible stitches available for other functions 
without affecting the hidden stitches. Selecting colors for display can be combined with 
the Draw Range to display a particular set of stitches that would be difficult to isolate with 
other functions.

If you have set a Draw Range, then only the stitches in the color blocks that are visible within the range will 
be displayed. Also, hidden colors are not highlighted when the mouse pointer is paused over them in the 
color worksheet.

Color Worksheet
The color worksheet on the Design Panel shows the order in which 
the thread colors are used. The group of stitches using a particular 
thread color is called a color block. The color worksheet can be 
used to change thread colors, and to add thread effects. When the 
Modify tab is open, it may be used to hide and show the stitches in 
any of the color blocks.

When you pause the arrow pointer over a thread color in the worksheet, the 
corresponding threads in the embroidery are highlighted. Also, a popup 
description of the thread color appears.
The color worksheet can also be used to change the order of the 
color blocks, and to merge color blocks.

The first color in the embroidery is at the top of the list, followed by all the thread color 
blocks. The check boxes show which color blocks are hidden. The numbers show the order 
in which the colors are used, and the samples show solid blocks of each thread color in 3D.

Double-click a thread sample, or select the thread and click the Change Color  icon to 
access the Color Selection dialog box and select a different thread color, or add thread 
effects. When on the Modify tab, click a check box to show or hide a color block. When a 
color is hidden, its check box in the Color Worksheet is not selected, as shown here:

Hidden Visible
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Move and Merge Color Blocks
Use the arrows below the color worksheet, or the right-click Context menu, to change the 
order of the color blocks, and to choose color blocks to merge together selectively. 

For example, you can keep two adjacent identical color blocks in case you wish to vary them later. If you 
use ColorSort, all identical colors will be merged unless there are overlapping stitches.
The changes you make are applied immediately.

This may be useful if you want to merge two blocks of an identical thread color without affecting the color 
order of the rest of the embroidery. For example, use Move and Merge Color Blocks to assist in creating 
lettering with some characters in varying colors. Alternatively, the Move and Merge Color Blocks functions 
may be useful if ColorSort does not merge colors owing to a few overlapping stitches that do not affect the 
design stitchout.
You can also use Merge when optimizing designs with multiple areas of cutwork and stabilizing lines. 
ColorSort may occasionally merge stabilizing lines in these circumstances.

Move Colors
The Move Up  and Move Down  buttons move the selected color block so that the 
colors are stitched in a different order. Click the required color in the list and it will be 
highlighted, then click the Move Up or Move Down button to move the color to the 
required position.

Alternatively, right-click the block and select Move Up or Move Down from the Context menu.

Merge Colors
The Merge Colors button  will merge the selected color block with the color block 
above it, removing the Color Change command.

Alternatively, right-click the block and select Merge into Previous Color  or Merge into Next Color from 
the Context menu.
Use Merge to delete color changes. Also use it to merge color blocks with the same thread 
color, after first moving one of the color blocks so that they are adjacent.

Insert Color Command
Use Insert Color Command  to add a new color change at the point where you click.

Click the icon and the pointer changes to the insert color pointer . Then click on the 
stitch where you want the color change. The Color Selection dialog box is displayed for 
you to select the thread color for the new color change.

Insert Stop Command
Use Insert Stop Command  to add a command which instructs the embroidery 
machine to stop at the point where you click, displaying a message.

Insert a Stop Command
1 Open an embroidery, then click the Modify tab.
2 Click Insert Stop Command and the pointer changes to the insert stop pointer . 
3 Click on a stitch. The Stop dialog box opens.
4 Use the Quick Text drop-down menu to insert a stitchout hint, or enter a message. 
5 Click OK to place the Stop Command.
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Stop Properties
Add a stitchout hint to a Stop Command in the Stop 
properties dialog box.

Select a Quick Text comment from the drop-down menu, or 
enter text in the Comment text field. Click OK to save the 
text. Up to 200 characters may be entered.

Draw Range
The draw Start and End slider bars on the Modify tab provide a very powerful way of 
viewing an embroidery and understanding exactly how it is formed. They allow you to 
progress forwards and/or backwards through an embroidery stitch by stitch and isolate a 
specific sequence of stitches. If desired, select the visible stitches as a block to work on 
with Select All Visible, without affecting the hidden stitches. Changing the range of 
stitches can be combined with selecting colors to display a particular set of stitches that 
would be difficult to isolate with other functions.

Draw Range (Slider Bars)
The upper slider bar sets the Draw From Start stitch. The lower slider bar sets the Draw To 
End stitch.

Use the Draw Range to set the Start or End stitch in any of the following ways:

• Click and drag the slider box along the slider bar.
• Click the arrows at either end of the slider bar to progress by one stitch at a time. Click 

and hold on an arrow to progress more rapidly.
• Click in the space on the slider bar on either side of the slider box to move in that 

direction and jump through the stitches rapidly. You can also click and hold, but the 
slider box will stop when it reaches the arrow pointer.

In all cases, the work area will show the range of stitches as the Start or End stitch changes.

When you set a Draw Range, only the stitches in the color blocks that are visible within the range will be 
displayed.

Draw All Stitches
Use Draw All Stitches , on the Modify tab, to display all stitches in the embroidery 
selected for editing. When you have hidden stitches by changing the color selection or the 
Draw Range, click the icon to view all stitches again. All the color blocks will become 
visible and the Draw Range will be reset to all stitches.

Drag the slider Click the + or - button Click the space by the slider



PREMIER+™ 2 Card Shop   Getting Started with PREMIER+™ 2 Card Shop               75

13Getting Started with 
PREMIER+™ 2 Card Shop
Welcome to PREMIER+™ 2 Card Shop. With PREMIER+™ 2 Card Shop you can create 
personalized embroidery cards automatically with themed templates for special 
occasions. After creating your card, it is saved as a group so you can easily edit the 
lettering or change a design in PREMIER+™ 2 Embroidery Extra.

Select from hundreds of templates to design one-of-a-kind greeting cards, invitations, 
postcards and certificates with your loved ones’ names embroidered beautifully as part of 
the project. In the special Postcards themes there are templates with space for a stamp, 
address and message.

PhotoStitch Wizard
PREMIER+™ 2 Card Shop includes the PhotoStitch Wizard. Use the PhotoStitch Wizard to 
automatically create embroideries from a photo. Choose from: Color PhotoStitch 
Embroidery, Sepia PhotoStitch Embroidery, Monochrome PhotoStitch Embroidery, Color 
Tile Embroidery, Linear PhotoStitch Embroidery and Printed Appliqué.

Color PhotoStitch, Sepia PhotoStitch, Monochrome PhotoStitch and Color Tile PhotoStitch options are 
available only if you own PREMIER+™ 2 ULTRA.

Parts of the Software Window

Menu Bar
There are five menus: File, Edit, View, QuickLink and Help.

Menu bar Toolbar Title Bar

Status BarTabbed Pages Design Area

Text Area

Work Area
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To access the menu options, use the mouse to pull them down from the menu bar.
An alternative way to access menu choices is to press the Alt key, then the underlined 
letter of the menu name, followed by the underlined letter in the menu option, 
e.g. Alt, F, N to start a new project.

Work Area
The work area is the area where the card is created. Stitches are drawn in the appropriate 
colors, and the embroideries are shown in 3D. 

The tabbed pages at the top of the work area are used to view the pages of the card. 

Press the Tab key to select each area of the page in turn.

The number of tabbed pages depends on whether Folding Card, Double-Sided Card, or Single-Sided Card 
was selected in the Select Theme and Layout page of the New Project Wizard.
Switch between pages by clicking the tabs at the top of the window, or use the shortcut keys Ctrl + Tab or 
PgUp and PgDown.
The work area may contain one or more text, design or image areas. Right-click the 
selection box around an area to edit it. 

The color of the default background can be changed using Card Color . A background 
fabric may be displayed using Background .

PREMIER+™ 2 Card Shop Terms and Conventions
Embroidery File Formats
Embroideries may only be saved in .vp4 format as this will preserve the separate parts of 
multipart designs. It also preserves thread color information and notes.

To export and stitch out designs created in PREMIER+™ 2 Card Shop, Save or Copy your project, then use 
PREMIER+™ 2 Embroidery.

Picture Files
PREMIER+™ 2 Card Shop can load any of the following picture file formats in the 
PhotoStitch Wizard: Windows or OS2 Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), 
Portable Network Graphics (.png), Tagged Image File Format uncompressed (.tiff, .tif ), 
Windows Meta File (.wmf), Windows Enhanced Meta File (.emf) and Windows Icon (.ico).

PREMIER+™ 2 Card Shop can upload pictures and videos of embroidery designs from 
Design Player to the social media sites Facebook® , Flickr® , Twitter®  and 
YouTube® .

Backgrounds
PREMIER+™ 2 Card Shop loads fabric backgrounds that are installed with the PREMIER+™ 2 
Embroidery System. To create new backgrounds, use PREMIER+™ 2 Embroidery Extra.
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14New Project Wizard
Use the New Project Wizard to select a template to create an embroidered card. Choose 
the best size for each project. Select from five different sizes, depending on the card you 
wish to make and the time you can set aside for embroidery. Template orientation may be 
portrait, landscape or square, whichever you prefer.

Choose a folding card with four sections, a double-sided card with two sections, or a 
single-sided project.

Click New  to start the New Project Wizard.

Select Theme and Layout

Theme
Select a theme from the list. The preview pane displays the first card template in the 
selected theme.

Layout
Select from three layouts:

Folding Card
Create a folding card with front, inner and back pages, such as a greeting card.

Double-Sided Card
Create a card with front and back pages, such as a postcard.

In the special Postcards themes there are templates with space for a stamp, address and message.

Single-Sided Card
Create a single-page project, such as a certificate or announcement.
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Select Template

Use the Select Template page to choose the card template you wish to use. Select a 
template category from the drop-down list, or use Search for Keywords  to search 
templates by key words in their names.

Select Size and Hoop

Select a preset dimension or choose a hoop. Choose whether to use a single embroidery, 
or multiple embroideries.

The Hoop Options will not be available (will be grayed out) if a single-sided project is chosen, or if the hoop 
is too small to contain the entire project as a single embroidery.
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How to Create a Golden Anniversary Card
1 In the main toolbar click New  and the Select Theme and Layout page of the New Project Wizard 

will appear. An Anniversary card template is displayed.
2 Scroll down the Theme list on 

the left and select the Christmas, 
then New Baby themes. The 
preview pane will show the first 
card template for each theme.

3 Select Anniversary, and in 
Layout ensure that Folding Card 
is selected.

4 Click Next. The Select Template 
page will appear.

5 In the ’Search for keywords’ text 
box, enter:
50

6 Place the pointer over the 
portrait format 50th anniversary 
card with the champagne bottle 
design.
If you position the arrow pointer over a thumbnail without clicking, the name of the template will be 
shown. The template is called '50th Anniversary 1 Portrait'.

7 Click the '50th Anniversary 
1Portrait' thumbnail and the 
template will appear in the 
Preview area.

8 Click Next. The Select Size and 
Hoop page will appear.

9 In the Select Size area, select 
Small 125mm x 175mm (5" x 7").

10 Click Change Hoop and the 
Hoop Selection dialog box 
appears.

11 Ensure Enter Hoop Size is not 
selected.

12 Click the drop-down arrow for 
Hoop Group and select 
Universal. 

13 Click the drop-down arrow for 
Hoop Size and select 360mm x 
350mm - Universal Multipart 
Hoop 1, then set Orientation to 
Rotated.

14 Click OK. The hoop is previewed 
in the wizard page.

15 In Hoop Options select ’Single 
embroidery’.
PREMIER+™ 2 Card Shop will 
create a four-section card with 
the layout optimized to fold and 
stitch.
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If a smaller hoop is to be used, select ’Multiple embroideries’ to create separate embroideries for the front, 
back and inner pages of the card.

16 Click Finish to close the wizard. The 50th anniversary card is in the middle of the work area, showing 
the front page of the card.

17 Click the Inner tab, or click Ctrl + Tab, to view the middle pages of the card.

18 Click the Back tab to see the back page of the card, then click Front to return 
to the front of the card.
Alternatively use Ctrl + Tab to move between pages, or the PgUp and PgDown 
keys.

19 In the work area, move the arrow pointer over the bottle. The pointer 
changes to a flower head .
The flower head pointer indicates that this is a design.
Designs in PREMIER+™ 2 Card Shop are made with relatively loose density 
stitching suitable for stitching on flat fabric and, in some cases, paper.

20 Move the pointer over the Wonderful Years text. The pointer changes 
to the letter A text pointer .
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15Viewing Card Designs

Selecting Pages and Areas
Selecting Pages
To select card pages, click on the tabs at the top of the work area.

Alternatively, use keys to move between pages in the card:

 The PgUp and PgDown keys will show the previous or next page.
 Use Ctrl + Tab to show the next page.
 The End key will show the final card page.
 The Home key will show the first card page.

See “How to Create a Golden Anniversary Card” on page 79.

Selecting Areas
To select areas within a card page, for example lettering, designs or images, click on the 
desired area.

Alternatively, use the Tab key to select areas in the card and move between them.

You can only select card areas with the Tab key if there is more than one design, image, or piece of lettering 
on the page. Otherwise, click the desired area to select it.

Zoom Commands
A number of functions are available to make it easier to navigate around the project, 
including the Zoom functions. By default, the project is shown at a size so that it fills the 
window, the same as if you click Zoom To Fit after zooming in or out.

View Background
Use the View Background features to change the color or fabric of the card background, 
and to move a card fabric background.

 Use Card Color  to change the color of the default background fabric for your project.

 Use Background  to select a background fabric.

 Use Move Background  to move the fabric background.

Move Background is only available after a Background has been selected.

Card Color
Use Card Color  to select the background fabric color for your project. The Card Color 
dialog box will appear.

Click and drag to zoom in on an area

Zoom to Fit
Drag to zoom in and out

Click to zoom in instantly
Click to zoom out instantly

Select or input percentage zoom
100% zoom
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Card Color  changes the color of the default fabric background. To change the fabric, use 

Background .

Click the Color drop-down arrow and select a color, or click 
More Colors on the drop-down panel to display the Colors 
dialog box with the Standard tab selected.

Reset to Template
To return to the original settings for the background color, 
click Reset to Template.

Move Background
Use Move Background  to move the background that you have placed behind your 
project.

Click the Move Background icon  and the mouse pointer changes to a four-headed 
arrow . Click and drag to move the fabric background around the project area.

Right-click to deselect.

Design Player
Use Design Player to play through the stitches of the current card project as if it was being 
stitched from an exported embroidery. All parts of the project are shown, whether or not 
they are selected.

If the card project will create multiple embroideries when saved, only the embroidery on the current page is 
shown.
The current Optimize for Sewing settings from PREMIER+™ 2 Configure are used.

Start or pause play

Control play with
the slider

Design Information

Jump to first stitch

Jump to last stitch
Rewind

Play at double the
current speed
Share a picture or
video online
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16Editing Your Project

Saving Embroideries
There are two methods of saving embroideries:

Save As
This displays the Save As dialog box so that you can save a the project with the existing file 
name, or a new file name.

If you save a project with the same name as an existing project, a dialog box will ask if you 
want to go ahead and overwrite the project with the revised version.

To export and stitch out designs created in PREMIER+™ 2 Card Shop, Save or Copy your project, then use 
PREMIER+™ 2 Embroidery.

Save On Close or Exit
If you make changes to a project, then try to close the project before exporting, a message 
will appear, asking if you want to save the changed project.

If you exit PREMIER+™ 2 Card Shop or use New to close the project then you will be asked 
about the project that you have changed without saving. Choose between:

Save As
Use Save As  to save the card as a multipart embroidery in .vp4 format. This saves the 
embroidery with the name you give it in the Save As dialog.

Save As will overwrite the existing embroidery. If you want to save another version of the same project, 
change the name before saving.

Yes Save the changes to the project. If it is a new project, show 
the Save As dialog box.

No Do not save the project and continue. Any changes to the 
project are lost. If it was a new project then it is discarded 
without being saved.

Cancel Do not save the project, but keep the project open and do not 
close PREMIER+™ 2 Card Shop.
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Copy
Use Copy  to make a copy of the currently selected page of the card. The copy becomes 
the Clipboard Block, where it can be pasted as an embroidery into another PREMIER+™ 2 
Embroidery System module.

To ensure the desired page is copied, make sure a design, lettering or image box is selected. 
All embroideries on the page are grouped together when copied. Combine, ColorSort and Remove Overlap 
are not applied, so that you can continue to adjust your card page in PREMIER+™ 2 Embroidery using 
Restrict Groups.

Copy All Pages
Use Copy All Pages  to make a copy of the whole card. The copy becomes the Clipboard 
Block, where it can be pasted as an embroidery into another PREMIER+™ 2 Embroidery 
System module.

All embroideries on the card are grouped together when copied. Combine, ColorSort and Remove Overlap 
are not applied, so that you can continue to adjust your card in PREMIER+™ 2 Embroidery using Restrict 
Groups.

Undo
Use Undo  to reverse the last action. If you are not satisfied with the result, click Redo.

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result, click Undo.
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